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GETTING STARTED 
PAGES3D 2017 
Pages3D is an easy-to-use page design product that leverages existing 3D models to create 
multiple-page documents. The software is as easy to install and use as standard Microsoft® 
Office products. Right out of the box, Pages3D includes a powerful set of 3D tools for working 
with 3D models,  creating parts lists, adding buttons, inserting tables and including formatted 
text. This enables anyone to author complete printed or interactive documents. 3D CAD 
software is NOT required. 

 

  

WHAT DO I DO WITH PAGES3D? 
• Author complete documents leveraging 3D and associated metadata 

• Use a single product that includes both page design and 3D tools 

• Publish documents as printed outputs with high resolution imagery 

• Publish multiple-page documents to PDF as static or interactive 3D documents 

• Publish multiple-page documents to HTML5 with embedded interactive 3D 

• Publish 3D content to Share3D for cloud-based sharing 
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HOW DO I USE PAGES3D? 
When using Pages3D, the goal is to create a final document. Pages3D provides tools for both 
working with 3D and for designing professional page layouts across multiple pages. Although, 
Pages3Dis a creative documentation tool and there is no required process for creating 
documents, the following steps are typical. 

  

To use Pages3D to create a printed document 
• Create a new document or start from a pre-designed template 

• Import a 3D model 

•  Insert text, insert images, insert 3D views, insert tables 

• Setup 3D views - Change Materials, change the render style, setup 
viewpoints, create exploded views, orient the 3D model, capture 
Illustrations, add balloons and other markups, etc. 

• Print 

  

To use Pages3D to create an interactive 3D document 
• Create a new document or start from a pre-designed template 

• Import a 3D model 

• Insert text, insert images, insert 3D views, insert tables, etc. 

• Setup 3D views - Change Materials, change the render style, setup 
viewpoints, create exploded views, orient the 3D model, capture 
Illustrations, add balloons and other markups, etc. 

• Capture illustrations - Set up animations with order, timing and transitions 
with a storyboard. 

• Add interactivity such as buttons and clickable parts  tables as desired. 

• Publish as an interactive 3D PDF or 3D HTML5 document 

  

PAGES3D USES AND APPLICATIONS 
Manufacturing instructions, user guides, illustrated parts lists, service procedures, marketing 
brochures and other product documents are necessary to get your products to market. As more 
products are designed with 3D design software, such as Solid Edge, SolidWorks®, 
Pro/ENGINEER® or Inventor, it becomes critical to reuse these highly informative 3D models for 
the creation of documents and communications. 

Today, most companies go through a lengthy process that requires the author to manually 
capture images, manually create bill-of-materials, manually add callouts and then insert the 
images and tables into a word processing program. When updates are required the entire 
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process is repeated. This multi-step, multi-program approach significantly limits documentation 
quality, effectiveness, ease-of-creation, maintainability and time-to-market. 

With Pages3D, customers report an immediate time-savings of 80% or more for document 
creation when compared to common methods in practice today. In addition, the software 
allows users to update documents seamlessly when 3D CAD designs change, saving days of 
rework. 

  

PAGES3D KEY BENEFITS 
• Minimize the documentation burden on engineers by letting anyone access and 

reuse 3D 

• Easily supports the reuse of 3D models, 2D drawings, parts lists, images and text 

• Save time by publishing the same document to print, web or interactive 

• Update entire documents in a single step when 3D CAD designs change. 

• As easy to install and use as Microsoft® Office products 

• Designed to be used by anyone, not just engineers 

• Eliminates the need to switch between multiple programs by integrating 3D with 
page design 

• Includes all the 3D tools needed to create complete documents 

• Easily manage call numbers by associating illustrations with a parts list 

• Exceptional tools for managing and working with large models 

• Highly competitive pricing allows entire teams to benefit 

• No need to purchase expensive and complicated 3D CAD tools for non-engineers 

  

PUBLISHER3D 2017 
Publisher3D is an easy-to-use technical illustration program that leverages existing 3D data to 
publish a wide-range of standard graphic, animation or document formats. With a very easy-to-
use interface, the software provides all the 3D power needed by today’s technical publishers. 

Publisher3D includes unique capabilities such as tools for directly associating parts lists with 
illustration call numbers, and an intuitive illustration workspace. Illustrations are published as 
template-based 3D PDF files, template-based HTML5 files, vector graphics, high-resolution 
raster graphics, as Word documents and animations. 3D CAD software is NOT required. 

Publisher3D includes the ability to publish storyboards to the Share3D cloud-based service for 
easy online sharing and collaboration. Share3D enables the use of mobile and desktop browsers 
for interactively viewing and commenting on shared projects. 
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WHAT DO I DO WITH PUBLISHER3D? 
• Create illustrations by capturing views and adding markups 

• Publish images, vectors or animations 

• Publish interactive 3D PDF through templates 

• Publish interactive 3D HTML5 through templates 

• Update illustrations quickly with 3D CAD designs change 

• Organize illustrations into a storyboard for animations 

• Use a Wide assortment of 3D Tools to create the view you want: 

o Exploded views 

o Balloons and Overlays 

o 3D Markups 

o Materials and custom Render Styles 

• Publish content to Share3D cloud-based services 

• Manage large 3D models with Configurations 

  

HOW DO I USE PUBLISHER3D? 
Typically, users of Publisher3D will focus on the creation of a set of illustrations. This set of 
illustrations is defined in Publisher3D as a storyboard. Once the illustrations are complete then 
they are published to the desired image format or as a PDF or HTML file. 

  

To use Publisher3D to create graphics 
• Import your 3D model. 

• Create one or more illustrations. Illustrations capture the viewpoint, render 
style, exploded state, and many other properties of the 3D view. 

• Add markups and callouts to your illustrations. 

• Publish your illustrations as raster or vector images. 

  

To use Publisher3D to create 3D PDF of HTML 
• Import your 3D model. 

• Create one or more illustrations. 

• Pick a single-page template. 
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• Customize the template, change the styles and colors, add logos 

• Preview the template and try the interactive buttons and 3D view 

• Publish your illustrations as a single page PDF or HTML document 

  

To use Publisher3D to create an animation 
• Import your 3D model. 

• Create a series of illustrations. Each representing a key frame for your 
animation. 

• Setup timing and transitions. 

• Publish the storyboard as an  animation. 

  

PUBLISHER3D USES AND APPLICATIONS 
Technical illustrations are an important method of communicating information about products 
and services. Typically, illustrators do not have access to 3D data and end up redrawing 
products from scratch using general purpose drawing applications. Today's illustrators are 
under constant pressure to meet an expanding list of publish requirements, publish formats 
and ever tightening timelines. 

Customers indicate that by using Publisher3D they get better results in minutes as opposed to 
weeks using other methods. Using Publisher3D provides multiple benefits including: time-to-
market improvements, quality improvements, more effective communication and generally 
happier customers. In addition, a full library of illustrations can be updated in minutes, rather 
than hours or days. 

  

PUBLISHER3D KEY BENEFITS 
• Minimize the burden on engineering by letting anyone access and reuse 3D 

• Easily produce high quality technical illustrations 

• Publish to modern 3D PDF and HTML5 formats with embedded interactive 3D 
views 

• Save time by publishing the same set of illustrations to multiple media such as 
raster, vector and animations 

• Update hundreds of illustrations in a single step when 3D CAD designs change. 

• As easy to install and use as standard office programs 

• Designed to be used by technical illustrators and graphical artists, not just 
engineers 
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• Eliminates the need to draft illustrations from scratch with general purpose 
programs 

• Includes all the 3D tools needed to create illustrations and animations 

• Easily manage call numbers by associating illustrations with a parts list 

• Exceptional tools for managing and working with large models 

• Highly competitive pricing allows entire teams to benefit 

• No need to purchase expensive and complicated 3D CAD tools for non-engineers 

• Publish informative content to Share3D cloud-services  

  

PUBLISHER3D OR PAGES3D? 
Document3D Suite is designed for anyone that wants to use existing 3D models to create 
downstream deliverable documentation. The included products are designed to work both as 
independent products or effectively together. 

Both products use the same 3D tools which makes it easy to learn one product and quickly 
transition to the other for different uses. 

  

WHEN TO USE PUBLISHER3D 
Publisher3D is specifically focused on the creation of a storyboard of illustrations. Once a 
storyboard is complete then these illustrations are then published to a chosen format. Some 
formats, like raster images, create a single image file for each illustration in the storyboard. 
Other formats, like interactive 3D PDF allow you to choose a template and then the illustrations 
are often used as an interactive 3D animation embedded in the PDF document.  

You should use Publisher3D when: 

• You want to batch create images for insertion into Word, Powerpoint, Illustrator, or 
another software 

• You want to quickly create a single-page interactive 3D PDF or HTML5 document and 
total control over the layout is not of concern 

WHEN TO USE PAGES3D 
Pages3D is used to create multiple-page  printed and interactive documents from existing 3D 
CAD files. This product includes both 3D and page layout making it easy to create full 
documentation using a single application. 

You should use Pages3D when: 

• You want to produce a custom printed manual with multiple pages complete with 
static 3D imagery, text, images, tables and more.  
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• You want to produce a custom interactive 3D document in PDF or HTML5 format. 
The resulting document can include interactive 3D views,  text, images, tables, 
clickable tables, buttons, and more. 

WHEN TO USE BOTH PRODUCTS 
In some cases, using both products in a process is a powerful approach to streamlining a 
documentation process. For example, it may make sense to have one person using Publisher3D 
to create the illustrations and another using Pages3D to include those illustrations in a printed 
manual or interactive 3D document.  

Also, given the variety of formats that customers demand it if often necessary to have both 
products to fulfill the diverse expectations for documentation and graphics. For example, it may 
be desired to provide interactive 3D work instructions using Pages3D to the shop floor, and 
high-resolution graphics using to the marketing department. Having both products often makes 
sense simply for the versatility. 

  

COMPARISON TABLE 
  

Description Publisher3D Pages3D 

Type Technical Illustrations Technical Documentation 

Authoring Create illustrations from a 3D 
Model 

Create documents using page 
design tools with embedded 3D 

3D Tools 3D Tools are common between 
products 

  

Document Features Single-page templates for PDF and 
HTML5 outputs 

Full-featured, multiple-page, 
customizable documents. Support 
for multiple 3D files in a single 
document. 

Interactive 3D PDF Single-page template Entire document publishes to PDF 
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Interactive 3D HTML5 Model-only or single-page 
template 

Entire document publishes to 
HTML5 

Working File Format QuadriSpace Model (QSM) QuadriSpace Document (QSD) 

Interoperability Save QuadriSpace Model (QSM) 
files that can be imported into 
Pages3D 

Export QuadriSpace Model (QSM) 
files that can be opened with 
Publisher3D 

  

•   

  

•   

WHAT'S NEW IN 2017? 
Document3D Suite 2017 includes many significant new feature as well a general improvements 
to the software. With 2017, for the first time, customers can create complete, ready-to-share 
HTML5 files based on Powered by Share3D™ technology. The 2017 release of Document3D 
Suite makes it easier than ever to product professional-quality technical documentation from 
your 3D CAD files in less time and with more versatility.  

• Powered by Share3D™ HTML5 

• Table of Contents 

• Font and Paragraph Styles 

• Parts List Hyperlinks 

• Parts List Drill-down Wizard 

• Solid Edge PMI 

• New HD and Mobile Templates 

  

FILE-BASED 3D HTML5 PUBLISHING 
Publish directly to industry standard HTML. The HTML files are based on Powered by Share3D™ 
technology so that interactive 3D documents can be viewed with any modern browser on PC, 
Mac, iOS and Android devices. Leaving you and your company free to host the resulting files as 
needed. Optionally, save as a single HTML file for easily sharing through email, on CDs or with 
offline computers or devices. 
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SOLID EDGE PMI SUPPORT 
Product Manufacturing Information (PMI) data can now be exported from Solid Edge and used 
to display accurate dimensions and annotations in your Pages3D documents and Publisher3D 
illustrations. PMI data can be published as part of your document to print, PDF or HTML5 for 
powerful interactive 3D communication. 

 

PARTS LIST HYPERLINKING 
Add hyperlinks to part list cells. Make it easier to navigate to supporting information by using 
the hyperlinks to link to other pages in the Pages3D document, to external web pages or to 
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other Pages3D documents. This is useful feature for creating parts list drill-down catalogs or 
links to external information such as vendor, product marketing information or spare part 
purchase links. 

 

  

PART DRILL-DOWN WIZARD 
Designed to make it easy to create part catalogs with drill down features. The wizard will insert 
a page for each part in a parts list and then add hyperlinks to each new page from the original 
parts list. This makes it easy to create multiple-page documents that allows viewers to start 
with a large complex assembly, select a subassembly and then drill down into that subassembly 
for further part selection and identification. This wizard is designed to make it very easy to 
create these complex and popular technical documentation publications. 

  

FONT AND PARAGRAPH STYLES 
Easily organize and maintain large documents and encourage consistent formatting in 
documentation with new font and paragraph styles. Styles can be used with text boxes, tables, 
dynamic text and tables, buttons and more. 

  

TABLE OF CONTENTS 
New table of contents feature leverages styles to automatically create a table of contents for 
your Pages3D documentation. Based on heading levels, the table of contents is easy to add to 
any document using styles. 
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NEW HD AND MOBILE TEMPLATES 
The 2017 release includes new modern designed templates that include support for new 
features like font and paragraph styles, table of contents and even templates that are ready for 
the use with the new drill-down wizard. Using styles with templates provides more versatility 
than ever before. In addition, HD and mobile device templates allow publications to leverage 
today's technologies for optimized viewing on modern devices. 

USER INTERFACE 
The graphical user interface (GUI) is designed to with a Ribbon user interface. 

This guide is focused on explaining only the interface tasks and commands that are specific to 
using the products. Standard Windows conventions will not be documented. 

  

GENERAL UI OVERVIEW 
This image shows the major interface elements an application: 
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Application Menu: Click to bring up the file menu and select options such as save, open, new, 
document settings, publish options, etc. 

Ribbon: The ribbon is divided into specific task-based commands organized into individual 
tabbed ribbons and ribbon groups. 

Panels: There are a number of panels in the software that allow you to leverage specific tools 
or view your document or model as a hierarchy or list. 

Document Window: In Pages3D the center window will show a WYSIWYG (what-you-see-is-
what-you-get) display of your 3D document. If you are using Publisher3D, this will be a full area 
view of the imported 3D model, called the Model Window. 

Model Window (not shown): In Publisher3D, the middle window will display a view of your 
imported 3D model. 

Quick Access Toolbar: This is a user configurable toolbar that can be customized with your 
common commands. To add a command to the Quick Access Toolbar, simply right-click the 
desired command in the ribbon and select: �Add to Quick Access Toolbar�. 
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Active Tool or Editor: A pressed button in the ribbon typically indicates the active tool or 
editing mode that the program is currently in. 

  

THE RIBBON 

 

Ribbon Tabs: The editing tools and commands are organized into individual ribbon tabs. Click 
on the tabs to switch. Switching tabs does not change the editing mode or modify the selected 
tool. 

Ribbon Groups: Common tools are organized into groups. Some ribbon groups (such as the 
Viewpoint group) will be available on multiple ribbon tabs. 

  

  

SPECIAL EDITING MODES 
For certain focused editing tasks, the user interface will enter a special mode. When in these 
special modes, the Document or Model Window may be modified to better display and allow 
easier editing. Examples of special modes include: Master Page Editing, Illustration Editing and 
Parts List Editing. 

When these modes are active, a check button will be display in the upper right corner. Click this 
check button to close the editing model and apply changes. 
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Mode Button: Typically an editing mode is entered when a ribbon button is pressed. This 
button can be pressed again to exit the special editing mode. 

Exit Mode: You can always exit special editing modes by clicking on the check button in the top-
right corner. 

  

WORKING WITH PANELS 
The software includes a number of panels for working with specific ribbon group elements. 

OPENING PANELS 
Panels can be selected and activated in two ways: (1) by clicking a relevant ribbon button and 
(2) by right clicking on the title bar or an active panel , shown below. 

 

CUSTOMIZING PANELS 
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Individual panels can be positioned as desired. Panels can be group together into a tabbed list 
of panels. The tabs are displayed at the bottom of the panel group. Clicking the tabs will switch 
panels. 

 

To position a group of panels: click on the title bar and begin to drag. You can dock panels or 
allow then to float. To dock a panel or group of panels, position your mouse over one of the 
docking indicator before you release. 

 

To position an individual panel: Individual panels can be removed from a docked area by click 
on the tab for the panel, holding the left mouse button down and the dragging the panel to a 
new location. 

To add a panel to a group of panels: Individual panels can be added to a group by dragging the 
individual panel and releasing the mouse over the center docking indicator. 
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PANEL ROLLOUT PROPERTIES 
Some of the panels organize commands and properties into rollouts. These state (open/closed) 
of the rollout can be toggled by clicking on the rollout title bar. 

 

STATUS BAR 
In Pages3D, the status bar includes a toolbar for adjusting the document view. 

 

Display Margins: Toggle margin display and snap-to on/off for page editing. 

Display Grid: Toggle grid display and snap-to on/off for page editing. 
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Display Rulers: Toggle ruler display on/off. 

Zoom: Indicates the current document zoom level. Click this to open a dialog to set the zoom 
manually. 

Zoom Scrollbar: Drag the slider to adjust the zoom level of your document view. 

Actual Size: Sets the document zoom level to 100%. 

Zoom to Fit: Automatically adjusts the zoom level to fit the entire document page into the 
document view. 

Zoom to Width: Automatically adjusts the zoom level to fit the width of the document into the 
document view. 

Zoom to Selected: Automatically zooms the document view to maximize the view of the 
selected page object (e.g. 3D view). 

  

  

CONCEPTS 
  

SOFTWARE TOOLS 

AUTHORING TOOLS 
Pages3D and Publisher3D are authoring tools that are used to create documentation and 
illustrations. 

Document3D Suite includes both but you may have purchased a license that only includes one 
or the other. 

Pages3D is used to create printed and interactive documents. 

Publisher3D is used to create illustrations for use in a variety of publishing options.  

There are a number of published formats shared between the applications and ultimately 
shared with others. 

Not only do the tools supply professional-grade support for importing common 3D CAD 
formats, but many standard text, image and graphical formats are supported as well. 

WHAT ARE THE IMPORT AND PUBLISH CAPABILITIES? 
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  Publisher3D Pages3D 

Imports 3D CAD 3D CAD, Text, Images, 
QuadriSpace Model (QSM) 

Saves/Opens QuadriSpace Model (QSM) QuadriSpace Document (QSD) 

Exports - QuadriSpace Model (QSM) 

Saves As...   QuadriSpace Template (QST) 

Publishes 

Raster Graphics, Vector 
Graphics, Movies, Template-
Based 3D PDF, Template-Based 
HTML5 

Custom Printed Documents, 
Custom 3D PDF Documents, 
Custom HTML5 Documents 
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ADD-IN EXPORTERS 
Exporter add-in utilities are available for many common 3D CAD products that allow users to 
export their 3D CAD data.  This provides access to those that do not have installed CAD 
software. Often export add-ins export more data than the importer.  

Exporters create QuadriSpace Model (QSM) files that can be imported into Pages3D or 
Publisher3D. 

  

VIEWING TOOLS 
Reader3D is a freely available Windows-based application for viewing files created with the 
Document3D Suite software. 

Reader3D opens illustrations created with Publisher3D and saved as a QuadriSpace Model 
(QSM) file.  

Reader3D opens documentation created with Pages3D and saved as a QuadriSpace Document 
(QSD) file.  

Reader3D maintains the interactivity of the 3D model or document but cannot modify the 
opened file. 

  

SHARE3D AND "POWERED BY SHARE3D" OVERVIEW 

"POWERED BY SHARE3D" FOR HTML5 DELIVERY 
"Powered by Share3D" technology is the foundation for a versatile assortment of HTML5 
publishing options. The technology is based on HTML5 and WebGL standards which are readily 
available on modern browsers and modern devices. The technology does not require a browser 
plugin. 

Powered by Share3D is the core technology for the following published outputs and web 
delivery products: 

• Folder-based HTML5 publishing feature included in Pages3D and Publisher3D.  

• Single-file HTML5 publishing feature included in Pages3D and Publisher3D.  

• Share3D Cloud - hosted HTML5 delivery of documents (www.share3d.com) 

• Share3D On-Premise - server product that can be installed locally for maintaining 
and serving HTML5 

SHARE3D CLOUD 
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Share3D Cloud is a hosted solution for delivering "Powered by Share3D" HTML documents. This 
is the easiest way to begin sharing your interactive 3D documents online. 

SHARE3D ON-PREMISE 
Share3D On-Premise is a local server solution for delivering "Powered by Share3D" installing 
and hosting the server your own web serving computers. The server includes features for user 
management, file management, versions and more.  

S3D FILES 
Document3D Suite enables you to publish to an S3D file. The S3D file is a published HTML-
Ready file that can be upload to Share3D Cloud or Share3D On-Premise. 
  
  

MODELS AND ASSOCIATED DATA 

THE 3D MODEL 
The use of Pages3D or Publisher3D relies heavily on the import of 3D models and associated 
data. Imported models can contain 3D geometry, assembly tree organizations, materials and 
part metadata. Some file formats include information related to exploded views, 
configurations, model views or PMI data created in the original CAD application. 

WHAT HAPPENS WHEN A 3D MODEL IS IMPORTED? 
When a 3D model is imported into the software, not only is the model and other data imported, 
the program automatically sets up a number of useful objects for you. 

Anytime a model is imported, you can expect to at minimum have access to the 3D geometry 
and an assembly tree representing the organization from the original CAD tool. Most file 
formats will support import of materials as well as some level of metadata. 

 

Often, it is possible to import more information from your 3D CAD tools than may initially 
import. In some cases, you may need to use an Exporter Add-in to gain access to the desired 
CAD data. 
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When a 3D model is imported the program automatically creates a master configuration, a 
master parts list and a default storyboard. 

 

MODEL TERMINOLOGY 
3D Geometry: This represents the actual 3D data that is used to render the scene. 

Assembly Tree: The assembly tree is the hierarchical structure that is imported with the 3D 
model. In most cases, the model tree will be identical to the model tree found in the 3D CAD 
application. Assembly trees contain multiple 3D parts and may contain subassemblies that 
organize subsets of parts. 

Part Metadata: Textual metadata assigned to individual parts. 

Configurations: Configurations are used to help manage large datasets, or variations of a 
design. A configuration defines which parts are used. Unused parts are referred to as 
suppressed. Configurations, by default, have a master parts list and encapsulate an unlimited 
number of parts lists and exploded views. Configurations can be used to vary materials as well. 
Configurations also have the ability to manage merged models, so multiple separate 3D CAD 
files can be brought together into a configuration. 

Materials: Materials determine the colors, texture and general appearance of parts when 
rendered into the 3D view. 
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Parts Lists: A parts list is a list of parts in the 3D model. The parts list defines a set of columns 
with additional information. The parts list is organized under a configuration and users can 
create and maintain as many parts lists as desired. 

Exploded Views: A organization of individual part movements from the original imported 
positions. Each movement may be a rotate, scale or translation. Creating exploded views does 
not permanently change the position of parts and allows users to select the exploded state, the 
unexploded state, or any individual step. Exploded views are organized as part of a 
configuration and users can create and maintain as many exploded views as desired. 

Individual Step: This represents a single movement of a part or a set of parts as a component of 
an exploded view. 

Step Metadata: Textual metadata that may be assigned to individual steps of an exploded view. 

  

WHAT CAN USERS DO WITH THE MODEL DATA? 

 

  

VIEWS, ILLUSTRATIONS AND STORYBOARD 
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When working with 3D, the typical goal for the user is to create views of the 3D model. This can 
be as simple as just setting up the view properly for single image publishing; or creating a 
document full of graphical content with many illustrations. It can also mean that multiple views 
must be captured as illustrations and then organized into a storyboard. The storyboard is the 
key to creating an imagery for batch publishing or creating an interactive document with 
interactive 3D capabilites. 

The following process is typical: 

• Setup the 3D view's orientation and render style 

• Save the current 3D view as an illustration 

• Add markups to the save illustration 

• Organize multiple illustrations with the storyboard 

THE 3D VIEW 
The view is used to display 3D models from various viewpoints, using various rendering styles 
and in various states. In Publisher3D, the view is the main working area and is used to create 
illustrations. In Pages3D, you will create and add 3D views to a document page and will create 
illustrations within these 3D views. 

 

A 3D view can be set up as desired by the user. The view defines the following characteristics: 

• Viewpoint 

• Render Style 

• Hidden Objects 

• Selected Objects 

• Exploded View and Step 

• Active Parts Lists 

• Sectioning Properties 
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THE ILLUSTRATION 
An illustration saves all of the data that defined a 3D view into a named group that can be 
recalled as needed or inserted into a storyboard. Additionally, each illustration can contain a 2D 
or 3D markups and users can add custom metadata to individual illustrations. Commonly, a 
name and optionally a description are assigned to an illustration.  

 
Illustrations capture: 

• All of the properties of the 3D view 

• A user-defined name that can be used to recall the illustration 

• An optional markup overlay 

• Textual metadata, such as a name and description 

THE STORYBOARD 
The storyboard is a named sequence of illustrations.  

In Publisher3D, this serves as the publish list for image publishing and as the animation 
parameters for movie publishing and as a list of illustrations when publishing PDF or HTMl5 
using a template. 

In Pages3D, the storyboard is used to organize illustrations for easy recall, set up a 3D view with 
an interactive animation, provide a list of illustrations on a document page, or display 
descriptive metadata text as individual illustration are recalled. 
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Storyboards are defined by: 

• A sequence of illustrations 

• A user-defined name that can be used to recall the storyboard 

• A set of transitions defining animation properties between ordered 
illustrations 

• A set of time values defining the length of time used to animate each 
transition, and the length of time to pause on each illustration. 

  

PAGE DESIGN 
In Pages3D, 3D viewing is integrated directly with a professional set of page design tools. The 
page design tools are used to create custom page layouts or templates. Common page design 
tools are found on the Home Ribbon and more specific page design tools are found on the 
Insert Ribbon or on the Layout Ribbon. 

 

THE PAGE 
A 3D document can contain multiple pages of information. The page represents an area where 
objects can be positioned to create a custom document. The page provides support for page 
size, margins, columns, rulers and other tools for laying out pages with precision. 
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PAGE OBJECTS 
Each page may include text, images, 3D views, shapes, etc; these are referred to as page 
objects. Page objects can be positioned and sized on the document page to create custom 
designs. 

3D VIEW 
A special page object is the 3D view. This object embeds 3D directly into the document page. 
This view can be used to orient the model in 3D space and modify other parameters such as 
render style, exploded view, current illustration, etc. 

When a document is printed 3D views are rendered to high-resolution images and placed 
within the resulting document. When an interactive 3D document is published, the view may 
maintain many of its interactive capabilities, allowing the recipient to pan, zoom and rotate the 
3D model inside the provided document.  

MASTER PAGE 
The master page provides a place to position page objects that are used on many pages 
throughout a document. This provides a place to put page numbers, set up logos and 
headers/footers. By default, the master page is displayed when any page is selected; however, 
the master page may be disabled for any individual page as desired. 

  

INTERACTIVE 3D DOCUMENTS 
Interactive 3D documents can include clickable buttons, tables and other interactive elements 
that can control the scene in a 3D view. These documents are generally published as industry-
standard PDF or HTML5 documents. 

INTERACTIVITY WITH ILLUSTRATIONS 
The most common method of adding interactive controls to a 3D document is to create a set of 
illustrations organized into a storyboard and create buttons or tables that tell the 3D view 
which illustration to display. Additionally, metadata that has been added to illustrations can be 
dynamically displayed in an Illustration Text page object. 
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In Example 1, you can see that the 3D view is displaying a named illustration, in this case 
�llustration 1� (blue arrow). The �Illustration Text� page object is connected to the 3D view and 
displays metadata that is associated with �Illustration 1�. This is shown by the dotted arrow 
from the text are to the 3D view. As different illustrations are selected, text will update to 
display the metadata specific to the currently displayed illustration. 

Example 2 shows a set of buttons that can be used to interactively tell the 3D view which 
illustration to display. The buttons are set up with actions such as �next illustration� or �first 
illustration�. These buttons are then connected to the 3D view, so that the view will react when 
a user presses the buttons. 

In the final example, Example 3, we have conceptually shown how an �Illustration Table� page 
object can be connected to a 3D view. This is a two way connection as shown by the dotted 
arrow. After the table has been connected to the 3D view, clicking on the table will tell the view 
to display the clicked illustration. If the view is set to a different illustration by some other 
means, such as the buttons from Example 2, the table will highlight the newly displayed 
illustration. 

INTERACTIVITY WITH PARTS AND STEPS 
This same connection of page objects and 3D views can be very useful for exploded views and 
parts lists too. For example, an exploded view can be set up with step-by-step procedures using 
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a strategy similar to the buttons in Example 2 above. A parts lists could be set up with a list like 
in Example 3 above where clicking a part in the list could highlight the part in the 3D View. 
�Part Text� and �Step Text� page objects can be used to display metadata associated with 
parts and explode steps similar to Example 1 above. 

  

TEMPLATES 
In many cases, it is beneficial to start a new project using a template. Pages3D includes a wide 
variety of templates that offer starting points for printed and interactive layouts. These 
templates are accessed from the "New from Template" command from the application menu. 

When you start a document from a template, you will be presented with a short wizard that 
allows you to select the document template followed by the initial 3D model. Once these 
selections have been made, the software will automatically create a document by inserting the 
3D model into any 3D views that were included with the chosen template. In many cases, 
interactivity that was setup in the template will be available in the generated document 
without further tweaking 

CUSTOM TEMPLATES 
Users are able to create their own custom templates, or modify one of the stock templates to 
better meet their needs. A template can be saved from any document using the "Save As > 
QuadriSpace Template" command. When a template is saved in this way, the result will be a 
QST file that includes all of the page layout information and the interactive connections 
between page objects and 3D views. 

  

SMART TEMPLATE TECHNOLOGY 
Smart Template Technology is a powerful capability that saves countless hours by automating 
the tedious generation of illustrations or document pages. This technology creates illustrations 
based on the parts list or exploded view. Pages3D even inserts these automatically created 
graphics into a document page. Inserted pages can be based on exploded views, parts lists, 
storyboards or configurations. 

AUTOMATE ILLUSTRATION CREATION 
One tool that makes significant use of Smart Template Technology is the Storyboard Wizard. 
This tool automatically creates a series of illustrations based on the current 3D view's settings 
and the selected part list or exploded step. 
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AUTOMATE PAGE CREATION 
The Page Wizard, available in Pages3D, creates and inserts document pages based on the 
choice of a template and either a parts list, exploded view or storyboard. 
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FILE FORMATS 

QUADRISPACE MODEL (QSM) 
The scene is made up of a number imported models and user-defined components. You can use 
the model editing tools to create, delete and edit these components. These 3D scenes are 
saved to the QuadriSpace Model (QSM) format and can be opened with Publisher3D or 
imported as a 3D model in Pages3D. 

The overall organization of a QuadriSpace Model is as follows: 

• Scene (QSM File) 
o Storyboard A 

 Illustration 1 
 User Meta-data 

 Illustration 2 
o Storyboard B 
o Configuration A 

 Parts List 1 
 Part 1 

o User Meta-data 
 Part 2 
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 Parts List 2 
 Exploded View 1 

 Step 1 
o User Meta-data 

 Step 2 
 Exploded View 2 

o Configuration B 
o Model 1 
o Model 2 

This hierarchy is represented in Project Panel in the software. 

 

  

Term Definition 

Scene The scene that includes imported models and user-created components. This is 
saved as a QSM file 
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Storyboard A storyboard is used to create an ordered booklet of multiple Illustrations. 

Illustration A memorized view of your 3D model. This may include callouts and other graphics. 

Configuration A configuration of the scene that defines which subset of parts is available and the 
material colors of parts. A configuration is a simple concept but great organization 
tool for working with large assemblies. 

Parts List A user defined list of parts, call numbers, quantities, and other fields. 

Exploded View A list of step-by-step movements of individual parts. 

Model An  imported3D model. Multiple CAD models can be merged into a existing scene. 

  

QUADRISPACE DOCUMENT (QSD) 
The QuadriSpace Document represents a multiple page document that can include text, tables, 
3D, images, 2D and more. This document can be creatively authored with the Pages3D product 
and then printed or published into industry standard formats, such as 3D PDF or HTML5. 

In addition to the terminology used to define a QuadriSpace Model, a QuadriSpace Document 
includes the following: 

Term Definition 

Document The QuadriSpace Document that is saved as a QSD file 

Page A single page of the document 

Master Page A page that provide a background or common look, feel and interaction in a 
document 

Page Object Graphical element that can be positioned on a page such as an image, text box, 
table, 3D view, etc 

  

QUADRISPACE TEMPLATE (QST) 
Pages3D can be used to create a QuadriSpace Template. These easy to use templates include all 
of the page design and setup, but do not include 3D models. Templates can be used to quickly 
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create a new document by combining the page design information stored in the template with 
the 3D information coming from an imported 3D CAD file or QuadriSpace Model (QSM). 

  

MULTI-CHANNEL PUBLISHING 
When Publisher3D is used to create documents, the information stored in the QuadriSpace 
Model is used. The following chart summarizes how information Is published. 

  

Published Format Illustrations Storyboard Information, 
Metadata, Parts Lists, Other 
text and data 

Graphics such as raster or 
vector images 

Multiple graphic files XML Index 

Documents such as PDF, HTML 3D view in the resulting 
template-based document  

Determined by chosen Template 

  

COMMON RIBBONS 
The following ribbons are used in Pages3D and Publisher3D. 

  

VIEWPOINT RIBBON GROUP 
The viewpoint ribbon group appears on many of the ribbon tabs. This group allows you to select 
the tool for manipulating the 3D view.  

 

Rotate: Hold down the left mouse button to rotate the 3D view. 

Pan: Hold down the left mouse button to pan the 3D view. 

Home: Instantly positions the model as an isometric view in the center of the 3D view. 

Zoom: Hold down the left mouse button to zoom the 3D view in and out. 
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Zoom to Area: Hold down the left mouse button to drag a box to indicate the desired viewport. 

Zoom to Fit: Instantly positions the model in the center of the 3D view. 

Select Parts: Left click parts to select. 

Select Assembly: Left click parts to select the parent subassembly. 

Hide Parts: Left click parts to hide. 

Hide Assembly: Left click parts to hide the parent subassembly. 

Standard Views: Select from a number of standard views. 

  

  

ILLUSTRATE RIBBON 

 

ILLUSTRATIONS 
The Illustrations ribbon group is used to create new Illustrations, select a specific Illustration 
and activate Illustration editing. Click the Illustrations button to capture the current view and 
create a new Illustration. Use the pull-down menu to select an Illustration from the current 
storyboard. 

Note: Only Illustrations in the current storyboard will be available for selection. 

ILLUSTRATION TOOLS 
The Illustration tools are used to add markups, graphics, callouts and dimensions to the current 
Illustration. These tools are only available if you are editing an Illustration. 

DRAW PLANE 
The draw plane group is used to set up the drawing plane that is used by the Illustration tools. 
The draw plane is displayed as a grid when Illustration editing is active. 
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Grid Menu: Pull-down to select the grid orientation. Options include: Front Plane for 
drawing in 2D and various options for drawing into the 3D scene. 

  

Snap-to-Grid: Toggle snap-to-grid. When active, dragging to position Illustration markups 
will snap to the grid lines. 

  

Adjust Grid Spacing: Increase and decrease the grid spacing. The snap-to-grid is affected by 
this adjustment. 

  

Position Grid: Click this tool to position the current grid in 3D space. Click on a part of your 
3D scene to align the grid with the selected part. Drag the mouse to adjust the grid. When 
you are finished positioning the grid, click this tool again to toggle it off. 

STORYBOARD 
The storyboard ribbon group provides tools for creating and selecting storyboards. Clicking the 
storyboard button will create a new storyboard. Using the pull-down menu you can select a 
storyboard. The individual Illustrations within the currently selected storyboard can be viewed 
using the first, previous, next, last buttons. To animate between Illustrations, click the 
"Animate" check box. The Group properties button will display the Storyboard Panel. 

Smart Template Technology is available using the Storyboard Wizard option from the "Select" 
pulldown. 

FONT/PARAGRAPH/COLORS 
Adjust the Illustration markup properties by using these ribbon groups. Extended markup 
properties can be set by clicking the Extended Group Properties button on the Colors group. 

Note: Markup colors can be affected by Theme settings. 

  

3D VIEW RIBBON 

 

SECTION 
The section button will activate the section properties panel. Use the tools in this panel to 
adjust your section planes. 

RENDER STYLE 
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The render style group allows you to select and manage your projects render styles. Render 
styles can be selected and custom style saved using the "Named Styles" pull-down. There are 3 
custom quick styles that you can set up to use as needed. Click the number to recall a 
previously saved setting, us the pull down arrow to capture the current render style for future 
use. 

To customize the render style, use the draw style pull-down to select the general style desired 
and then use the background, highlight, edges, trails, lighting and appearance buttons to 
customize. 

A detailed render style editor can be displayed by clicking the extended group properties 
button. 

Note: Render Styles can be affected by Theme settings. 

  

MATERIALS RIBBON 

 

Use the materials ribbon to select, create and apply materials to parts in your 3D scene. 
Material application applies to the current configuration only. The materials ribbon also include 
access to a stock library, a user library, and all materials currently used in the model. 

MATERIALS LIBRARIES 
This set of buttons allows you to select which materials are displayed in the Materials ribbon 
group. You can choose to display stock materials from our supplied material library, user 
materials that are created and saved by users, or the materials currently applied to the model. 

For Stock and User, you can additional choose a category so that you can easily find the 
material type you are looking for. 

Stock: Choose a category of stock materials to display in the Materials ribbon group. 

  

User: Choose a category of user materials to display in the Materials ribbon group. 
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Applied: Choose to display the materials applied to the current model. 

MATERIALS 
This ribbon group displays the thumbnails for the current library/category choice. From this 
gallery, you can select a material and use other commands from the pulldown menu to add 
materials to your user library. 

MATERIAL TOOLS 
Material tools are used to select, apply and edit materials by interacting with a 3D view. 

Pick Material: You can use the pick material tool to click on a part in the 3D scene and 
select the material. 

  

Apply Material: The apply tool allows you to click on a part in the 3D scene to apply the 
current material. 

  

Edit Material: When a material is selected and the Edit Material button is pressed, the 
properties panel will display the properties for editing. You can only edit User or Applied 
materials. Stock materials are uneditable. If you wich to tweak a stock material either create 
a copy by applying it to your model, or clone it and save it to your user library. 

  

MODEL RIBBON 

 

MODEL GROUP 
Model Panel: Click this button to display the model panel. The Model Panel is also displayed 
when the extended group properties button is clicked. 

  

Up Axis: This selects the �top� of the model, and affects the 3D scene�s behavior when the 
viewpoint tools such as top, bottom, etc are used. 

PARTS LISTS 
The Parts List group allows you to create and manage your custom Parts Lists. The pull-down 
will list all Parts list in the current configuration only. You can use the pull down to create a new 
Parts list using all of the parts from the current configuration. The parts list can be customized 
using the Parts List editor. 
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Export: Export the currently selected Parts List as and XLS (Excel), CSV or XML file. 

  

Import: Import an XLS (Excel) spread sheet as a parts list. 

  

Edit Parts List: Activates the parts list editor for modifying the currently selected parts list. 

The parts list property dialog is activated when the extended group properties button is clicked. 

EXPLODED VIEWS 
The Exploded Views group allows you to create and manage custom exploded views. The pull 
down will list all Exploded views in the current configuration only. 

Move/Rotate/Scale Parts: Use this tool to create/edit steps in an explode sequence. 

• Click a part to select a component to move. This will create a new step. 

• Hold down CTRL while clicking to add or remove parts from the current step. 

• Drag the components using the axis or by clicking on them. Alternatively you 
can adjust values from the Properties panel. 

• Repeat the above process to create multiple steps. 

• When finished, press the Check button found in the top-right corner. 

Return Parts: This is a special tool that is designed to make it easy to create assembly 
procedures. After an exploded view has been created, you can use the "Return Parts" tool 
to click on a part and return it to its original position. 

  

Change Axis: Assigned the axis for the current step. Moving the axis allows you to set the 
rotate point for more complicated steps. The axis can be set by object (center of and 
object), by point (click on a point in the model) or by face (axis will align itself to the 
selected face). 

  

Axis Type: Use this pulldown to choose how the move or rotate axis is selected. 

The Exploded View Panel is displayed when the extended group properties button is clicked. 

TOOLS 
The tools group provides a few tools that allow you to set up your 3D scene as you desire. 

Metadata: This tool The Metadata Panel button allows you to add metadata to your parts, 
exploded view steps and Illustrations. This metadata can be published to a document, XML 
index from Publisher3D or used to display text dynamically as different parts, steps or 
Illustrations are selected. 
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Part Privacy: This tool allows you to limit which metadata fields are exported when you 
create a PDF document. 

  

Mesh Decimation: Use this tool to reduce your model detail. Reduction in model detail is 
used to increase performance and decrease file size. Click to activate the tool, and then use 
the slider to adjust the detail. After you release the slider, the model will update so that you 
can review the changes. 

  

  

CONFIGURATIONS RIBBON 

 

CONFIGURATION GROUP 
The Configurations group encapsulates a set of tools for creating and managing configurations. 
Configurations make it easy to work with 3D models by allowing users to create subsets of 
parts, combine multiple models or create variants of models without re-importing the same 
model twice. 

Configurations: Use the configuration pull-down to select and create different 
configurations of your 3D scene. Configurations can be created from all visible parts, the 
currently selected parts or all parts. Depending on the selection, when a configuration is 
captured some parts may become "suppressed". Suppressed parts are permanently hidden 
as long as the configuration is active. Configurations are also used to capture material 
changes and to set the initial location of merged models. 

  

Suppress Selection: Suppress all selected parts for this Configuration. Click this button after 
first selecting all parts that you wish to suppress. 

  

Suppress Hidden: Suppress all hidden parts for this Configuration. Click this button after 
first hiding all parts that you wish to suppress. 

  

Suppress Tool: When working with a specific configuration, suppressed parts are never 
visible. And the editing tools act as if they do not exist. If you need to edit the set of 
suppressed parts after a configuration is created, the model panel can be used to 
"suppress" and "unsuppressed" parts. 
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MERGE GROUP 
These tools are used to merge multiple models into the same scene. 

Merge Model: Click this button to add another 3D model to your current 3D scene. It is 
important to select the right units for imported models to properly scale. The units should 
reflect the units used in the original CAD tool. (Note: if you need to adjust the units you can 
right click the model in the "Project Panel".) 

  

Move/Rotate/Scale Model: Use these tools to properly position imported models into the 
same scene. These tools are used to affect the initial position of models and parts for the 
current configuration. In contract, to create animations of step-by-step procedures, you 
should use a custom exploded view. 

UPDATE GROUP 
Update: The update tool allows you to update your entire document or set of Illustrations 
when 3D CAD files change. To use this important capability, click the button to bring up the 
update dialog. You can select which models should be updated and the path to the revised 
3D CAD file. 

  

  

RIBBONS UNIQUE TO PAGES3D 

HOME RIBBON 
The Home ribbon provides a basic set of the most common tools for working with your 3D 
document. This ribbon is only available in Pages3D. 

 

CLIPBOARD 
Standard Windows Copy/Paste Functionality for working with pages objects. 
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PROJECT 
The Project group allows you to insert create and delete document pages, insert 3D models and 
2D CAD drawings and switch between page object selection and interactive viewing of your 
document. 

Page Template: Using the "Page Template" pull down you can select from page templates or 
save your current page as a template for future use. Page templates save the page design so 
that they can be reused later with other models and in other documents. 

Smart Template Technology can be used by selecting a template and then choosing how to 
insert the template. This will give options to automatically set up the page based on and 
exploded view, storyboard, parts list or configuration. 

Project: The Project Panel is displayed when the "Project" Button is selected. 

SELECT 
Set the Edit Page mode, or display the properties panel. 

INSERT 
The Home Ribbon includes the most commonly used insertion tools. More can be found on the 
insert ribbon. 

FONT, PARAGRAPH & STYLE 
Set the text formatting and style. 

  

INSERT RIBBON 
The tools on the Insert ribbon can be used to create page objects on your document page. This 
ribbon is only available in Pages3D. 

To create a new page object: 
1. Select the desired tool from the Ribbon Panel (or Home Panel) 

2. Click on the document page to set the top-left corner. Drag to the 
bottom-right corner and release the mouse button to create. 

Page objects can use alignment tools like margins, grids and rulers. In addition there are tools in 
the Layout ribbon that will help you align and distribute page objects relative to one another. 
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EDIT PAGE 
Toggle edit page on to use the mouse to select, resize, position page objects such as text boxes, 
3D views, buttons, tables, etc. 

TEXT BOX 
The Text group includes a standard text box and three metadata associated text boxes. 

The standard text box allows users to type in text directly and format the text as desired. 
Alternatively, you can right click a text box and use the "Import Document from File"option to 
import Word, RTF or TXT files. 

The metadata associated text boxes will display text based on the current state of a 3D view on 
page. These are identified based on the type of metadata that the text box display (part, step or 
storyboard). 

TABLE 
The Tables group includes a standard table that can be used as needed. Right click the table and 
use the "Table >" submenu to modify the table as needed. 

A Parts Table can be used to place a Parts list on your document page. They parts lists can be 
set up as a standard table or as an interactive table that can be clicked to highlight parts in a 3D 
view. 

GRAPHICS 
The graphics ribbon group is used to create images, shapes, lines and other page objects. 

VIEWS 
The views ribbon group allows you to create interactive views of 3D models, 2D CAD drawings 
or images. In addition to the standard 3D view, you can create 3D walk through views or 3D 
sectional views. 
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Once you have positioned a 3D view on the document page you can use the Viewpoint Ribbon 
Group to select a tool such as Rotate to interact with the 3D object. 

STYLES 
Use the Style pulldown to select a paragraph or font style to be applied to the selected page 
object or selected text subset. 

You can also choose a document style from this menu that will be applied to the entire 
document. 

FONT/PARAGRAPH/COLORS 
Use these ribbon groups to set the visual properties of your page objects. 

Note: Page object colors can be affected by Theme settings. 

  

LAYOUT RIBBON 
This ribbon is only available in Pages3D. 

 

PAGE SETUP 
Use these choices to define the settings for your entire document. 

WINDOWS 
Switch between multiple Pages3D documents. 

THEME 
Select the theme for your current project. In Pages3D, Theme colors can be applied to page 
objects, Illustration markups and render styles. 

ARRANGE 
Align, group and distribute the currently select page objects. 

  

  

PUBLISH RIBBON IN PAGES3D 



Getting Started 

44 

This ribbon is only available in Pages3D. 

 

PRINT 
Print the current document to a printed or virtual PDF printer 

PDF (REQUIRES 3D PDF MODULE) 
Publish the current document as a PDF document. Options include the ability to create a PDF 
document with interactive 3D objects included. 

HTML5 
Publish the current document to industry-standard HTML5. Options include saving to a folder of 
files or as a single HTML file.  

  

RIBBONS UNIQUE TO PUBLISHER3D 

TOOLS RIBBON 
This ribbon is only available in Publisher3D. 

 

PROJECT 
The project ribbon will display the Project Panel to create, manage and edit your project.  

THEME 
Select the theme for your current project. 

WINDOWS 
Choose other QuadriSpace Model files that you are working on. 
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VIEWPOINT 
See description on 3D View Ribbon. 

  

PUBLISH RIBBON IN PUBLISHER3D 
This ribbon is only available in Publisher3D. 

 

To publish your 3D Illustrations use the Publish ribbon to select the following: 

• Select a publish type by selecting the desired Output 

• Choose a template (if approprate) 

• Select which illustration you would like to publish by clicking illustration or 
storyboard in the Source ribbon group 

o Illustration � publisher the currently selected view 

o Storyboard � publishes all of the Illustrations in the currently selected 
storyboard 

• Click "Publish Now" 

Once you have selected the type of information a preview of you graphics or document may be 
displayed in the model window. 

PUBLISH OUTPUT 
Use this pulldown to select the type of publish desired. 

PUBLISH GALLERY 
This gallery displays format or template choices depending on the Publish Output selected. For 
some publish outputs, you can save your current settings as a custom format for future use. 

SOURCE 
Select the list of Illustrations, documentation and parts lists you would like to publish. 
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THEME 
Select the theme for your current project. 

STYLES 
Use the Style pulldown to choose a document style from this menu that will be applied to a PDF 
or HTML template. 

PUBLISH 
Click the publish now button to begin publishing your selection. 

  

PANELS 

PROJECT PANEL 

 

The project panel provides a complete overview of your document or model. In addition to 
visualizing your project hierarchy, the project panel lets you accomplish the following: 

• Drag and drop to reorder pages in Pages3D 

• Drag a storyboard, illustrations, parts list, parts or other component to your 
document page to create a 3D view or a table in Pages3D 

• Drag a component to a 3D view to select a configuration, storyboard or Illustration;. 

• Drag a row from a parts list to display an isolated view of the row's part 

• Drag an exploded view or a specific step of an exploded view to display it in the 3D 
view 

• Drag a parts list to set the active parts list for an Illustration 
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• Right click any object the edit properties, activate an associated editor or to delete 
the element. 

  

MODEL PANEL 

 

The Model Panel provides an extensive set of tools for working with complex assembly trees. 
Basically this panel has three modes: tree, list and search. You can select the display mode from 
the pull-down at the top of the panel. 

Assembly Tree: Use a standard assembly tree to select, hide, show, suppress (per 
configuration) parts and subassemblies. 

Parts List: Use a list to select, hide show, suppress (per configuration) all parts of the same 
type. 

Search: Type in text to search part names and meta-data. Relevant parts are display 
instantly and can be selected, hidden, shown and suppressed (per configuration). 

Update: If an update has occurred on the model then this selection will be available and will 
display the unique parts that were added or removed during the update. 

In addition to the default modes, the Model Panel allows you to use custom Parts lists to select, 
hide and show parts. 

  

METADATA PANEL 
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The Metadata Panel is used to add textual information to Illustrations, parts and steps. This 
information is commonly used to provide text for dynamic text boxes as selections are made 
while viewing the interactive document. For example, an illustration text box will display the 
currently selected illustrations metadata fields as the 3D view displays an illustration. 

Another use is that this information can be used to publish an XML index with graphics and 
metadata so that they can be associated after publishing static imagery. 

Use buttons at the top of the Metadata Panel to select they item you are adding textual 
information to. 

Storyboard: information is added to each individual Illustration. 

  

Parts: information is added to each individual part. 

  

Step: Information is added to each individual step. 

  

PROPERTIES PANEL 
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The properties panel is used to edit the properties of most elements in the software. When in 
edit page mode, the page object properties can be edited here, when another editor is active 
properties are often available form this panel for editing.  

For example, the properties panel can be used to: 

• Display properties for selected items such as page objects or Illustration markups 

• Display properties when editing abstract 3D model elements such as materials, 
explode steps or sectional planes. 

  

VIEWPOINT PANEL 

 

The viewpoint panel provides a vast selection of industry standard axonometric views. This 
allows you to get the exact viewpoint for your Illustrations. In addition, using the viewpoint 
panel allows you to maintain consistent viewpoints across multiple Illustrations. 

  

RENDER STYLE PANEL 
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The render style panel allows you to modify many aspects of how a 3D scene is rendered. 

  

EXPLODED VIEW PANEL 

 

The Exploded View panel allows you to review or modify the step-by-step sequence of an 
exploded view. Using this panel you can reorder steps, delete undesired steps and group steps 
to create complex animations. 

The exploded view can be displayed as a tree (for grouping) and a list (for reordering) or as a 
timeline (for setting up complex animations). 

  

STORYBOARD PANEL 
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The storyboard panel allows you to reorder Illustrations in a storyboard, set transitions 
between Illustrations and manage a storyboard visually. The storyboard is commonly used to 
set up animations that will be published as a movie. 

EDITORS 
The software includes a number of Editors that provide focused functionality when the editor is 
activated. You will know that an editor is activated when a check button is display to the top 
right of the document or model area. 

To exit an editor and return to normal, simply click on the check button located in the top-right 
corner of the document or model view. This will close the editor and apply changes as needed. 

  

MASTER PAGE EDITOR 
The master page editor allows you to add page objects to the document's master page. Typical 
master pages may include text, graphics and page change buttons. This is only available with 
Pages3D. 

  

ILLUSTRATION EDITOR 
When the Illustration editor is active, any changes made to the 3D view will be captured by the 
current Illustration. The Illustration Editor is also used to add and maintain markups for the 
illustration.  

  

SECTION VIEW EDITOR 
When this editor is active, you can setup section planes. 

  

PARTS LIST EDITOR 
The Parts List editor allows you to add and delete custom rows and columns. 
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EXPLODED VIEW EDITOR  
When this editor is activated, you can create explode steps for an exploded view.  

  

MATERIALS EDITOR 
The Materials editor allows you to select and modify materials using the 3D view. 

  

CONFIGURATION EDITOR 
The Configuration Editor is used to supress and unsupress parts in a configuration. 

  

MERGE MODEL EDITOR 
The Merge Model Editor is used to merge multiple 3D CAD files into single scene. 
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AUTHORING 3D DOCUMENTS 
WORKING WITH 3D DOCUMENTS 
Pages3D includes page design features integrated with 3D tools, so that the creation of 
powerful printed or interactive manuals from scratch is easy and rapid. When working with the 
Pages3D software, your overall goal is to create a final document. 

This section will describe how your page layout can be set up, how page objects can be added 
to your document page, and how 3D can be inserted into the document and the information 
from your 3D model can be displayed as 3D views, tables or textually. 

  

CREATING A NEW DOCUMENT 
Pages3D is 3D page design software. Documents created with the software are saved and 
opened from a QuadriSpace Document (QSD) file that can include multiple creative pages that 
include 3D and other interactive views. When you create a new document you will be 
presented with a single blank page to begin authoring from. 
  
  

To create a new document 
• Choose New from the Application Menu (Hoy Key CTRL-N) 

  

CREATING A NEW DOCUMENT FROM A TEMPLATE 
You can create new documents based-on pre-designed templates or templates that were 
custome designed with Pages3D. 

  
To create a new document based on a template 

1. Choose New From Template...from the Application Menu 

2. From the first page of the wizard select whether you would like to use 
a stock template or a custom template 

3. Now click on the thumbnail of the template that you would like to 
start from 

4. Click "Next" 

5. On the second page, click "Browse" to choose a 3D model to import 

6. Click "Finish" to create your new document 
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IMPORTING A CUSTOM TEMPLATE 
With Pages3D, you can import and use other templates created in the software. Once a 
template has been imported it will continue to be available for future use. 

  

To import a custom template 
1. Choose New From Template� from the Application Menu 

2. From the first page of the wizard select the custom template tab 

3. Now click the "Import Custom Template" button and browse to the 
location the QuadriSpace Template (QST) file and choose OK. 

4. A thumbnail of the template should appear in your list of custom 
templates, click on it. 

5. Click "Next" 

6. On the second page, click "Browse" to choose a 3D model to import 

7. Click "Finish" to create your new document 

  

OPENING AN EXISTING DOCUMENT 
Pages3D opens QuadriSpace Document (QSD) files. 

To open a document 
1. Choose Open... from the Application Menu (Hot Key CTRL-O) 

2. Browse and select the QSD file you would like to open 

  

A common misconception is that Pages3D opens 3D models. Actually, the software imports 
models into a document. Pages3D is a complete page design product that saves and opens 
QuadriSpace Document files; saved to the extension QSD. You can easily import as many 3D 
models into a document as necessary.   

  

SAVING A DOCUMENT 
Pages3D saves document as QuadriSpace Document (QSD) files. 

To save a document 
1. Choose Save As... from the Application Menu (Hoy Key CTRL-S) 

2. Type in the file name 
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3. Click OK to save 

  

EXPORTING A TEMPLATE 
Pages3D can be used to create templates that can be reused with the New Document Wizard in 
Pages3D and with Publisher3D template publishing tools. For more information about 
templates, see About Templates. 

To export a template 
1. Choose Save As > QuadriSpace Template from the Application Menu 

2. Type in the file name 

3. Click OK to save 

  

SETTING THE DOCUMENT PAGE SIZE 
When you create a document you may want to set up the document's page size and 
orientation. This setting applies to the entire document. 

  

To set the document page size 
1. Select the Layout Ribbon 

2. Click the Page Settings button and select Page Settings 

3. Enter a Width and Height value manually or choose from preset 
standards 

4. Click OK. 

  

SETTING THE DOCUMENT METADATA 
Each document created with Pages3D includes the following metadata fields: Title, Author, 
Subject, Company, Project. You may desire to set these to organize your documents or to reuse 
the fields as part of the document. 

  

To enter document metadata 
1. Choose File Prepare > Document Settings from the Application Menu 

2. Select the "Summary" tab 
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3. You can enter text for each of the following fields: Title, Author, 
Subject, Company, Project 

Document metadata is also useful when reusing templates for different purposes. For more 
information about templates, see About Templates. 

  

SETTING THE DOCUMENT INTERACTIVE OPTIONS 
Pages3D lets you set various settings for how an interactive document will behave when viewed 
by a recipient. 

  

To modify a document's interactive settings 
1. Choose File Prepare > Document Settings from the Application Menu 

2. Select the "Interactive" tab 

3. Set the global settings for this document 

  

SETTING UP A DOCUMENT 
In many applications it is very difficult to include 3D models in manuals and documentation. 
With Pages3D, you can easily include 3D with printed or interactive documents. The software 
includes all the tools you need to create complete, creative multiple-page documents. 
  
All you need is a 3D model! 
  
Pages3D opens and saves to the highly-compressed QuadriSpace Document (QSD) format. 
There are numerous publishing options including: printed documents, 3D PDF, HTML5 and 
more. 
  
Pages3D also provides an extremely familiar and intuitive way to create 3D PDF documents 
with interactive 3D objects. 
  
With Pages3D, you can accomplish all of the following from a single application: 

• Design pages with creative tools 

• Interactively view and edit a 3D model 

• Publish Interactive Documents 

• Publish Printed Documents 
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CREATING A NEW DOCUMENT 
Pages3D provides tools for creating complete multiple-page documents. You can create a new 
document from a template or as a empty blank page. 

To create a new document 
• Choose New from the Application menu. 

  

IMPORTING A MODEL 
You can import a 3D model that has been previously saved from a 3D modeling program. For 
some CAD packages, exporter add-on products are available  that allows a CAD user to export a 
QuadriSpace Model (QSM) file from within the CAD interface. In some cases, this may allow you 
to access additional information from your CAD files.  
  

To import a 3D model 
• Select the Home ribbon and click Import 3D 

  

EDITING THE PAGE LAYOUT 
Pages3D includes the ability to creatively design document pages. 

Item What can I do? 

Pages and Imports - Each 
document is composed of one or 
more pages and any number of 
imported 3D files. 

• insert new pages 

• select a page 

• reorder pages 

• edit page properties 

• import 3D, 2D and image files 

• update imported files when they are revised 

Objects - Pages can be creatively 
authored using any of the tools 
found on the Insert Ribbon. 

• insert a new page object 

  

To create a new page object 
1. Select the Home or Insert Ribbon 



Authoring 3D Documents 

58 

2. In the ribbon, click on the desired page object (such as a text box) 

3. Place the cursor over the current page. This cursor should indicate 
that you are ready to create the new object. 

4. Click and hold down the left mouse button to select the top-left 
corner of the object 

5. Drag the mouse and release the left button to select the bottom-right 
corner and create the new object. 

  

To select a page object 
1. Select the Insert Ribbon 

2. Click on Edit Page 

3. Click on the page object 

  

When a page object is selected the selection will be indicated by a set of visible handles located 
around the object. You can use these handles to resize the object. 

  

INTERACTING WITH A 3D VIEW 
In order to adjust the 3D viewing position, edit model properties or to test interactive behavior 
you should select any of the interactive tools in the Viewpoint Ribbon Group. This group is 
located on most ribbons, including the Home ribbon. When an interactive tool is selected, you 
can use your mouse to interactively rotate, pan and zoom the 3D objects.   

  

PUBLISHING PRINTED AND INTERACTIVE 3D DOCUMENTS 
Once you have completed your page design and added the necessary interactive capabilities, 
you can publish an interactive document or print the entire document. 

WORKING WITH THE DOCUMENT WINDOW 
When you first create or open a document, Pages3D will display a view of the document in the 
document window. 

  

 ADJUSTING THE DOCUMENT ZOOM 
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The document view can show different zoom levels of the current page. You can adjust the 
document view zoom using the zoom controls embedded in the status bar below the document 
view. The software supports zoom levels from 10% to 400%. 

 The zoom controls can be used to: 

• set the zoom to 100% 

• zoom to fit entire document within document view area 

• zoom to fit document width within document view area 

• zoom to fit the currently selected page object 

• decrease zoom 

• increase zoom 

Note: You can also manually adjust the zoom level click on the zoom percentage indicator 
to display a zoom dialog box. 

  

USING DOCUMENT GRIDS AND GUIDES 
The document grids and guides provide tools for precision placement of page objects. You can 
display and snap to guides based on your margins settings or grid lines. When snap to grid is on, 
when you move or resize page objects, they will align with guides or grid lines. 

Guides are based on your documents margin and column settings. They are indicated by blue 
lines. Grid lines are user configurable and are displayed as a light gray "graph-paper" style grid 
behind page objects. 

  

Note: Guides and grid lines are only displayed when you are insert a new page object or 
have selected �Edit Page� from the Insert Ribbon. 

  

To show and snap-to margins or grid lines 
1. Select the Insert Ribbon and click "Edit Page" 

2. Click on the small Toggle Grid or Toggle Margin button in the status 
bar below the document window.  
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Note: You can also right click on the page background to adjust margin and grid settings. 

  

SETTING THE GRID SPACING 
Grid spacing determines the snap-to points when creating or repositioning page objects. By 
increasing or decreasing the spacing, you can customize the alignment of page objects. 

  

To set grid spacing 
1. Select the Insert Ribbon and click Edit Page 

2. Make sure that the grid is toggled ON by making sure the grid icon is 
enabled in the status bar 

3. Click on the small Increase Grid Size or Decrease Grid Size button in 
the status bar below the document window. 

  

SETTING THE MARGINS AND COLUMNS 
Another method for setting the way that objects snap-to and align themselves on the page is to 
activate and customize the margins and columns. 

  

To set the margins and columns 
1. Select the Layout Ribbon 

2. Click on the Margins button and select a preset 

3. Click on the Columns button to choose the number of columns 

To set the margins and columns manually 
1. Choose the Layout Ribbon 

2. Click on the Margins button and select Margin Settings� 

  

Top, Bottom, Left, Right Margin in inches 

Columns Number of columns per page 

Gutter Distance between columns in inches 
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DISPLAYING RULERS 
Rulers can be displayed to provide a visual indication of offsets from page boundaries or 
between page objects. 

  

To toggle the rulers on and off 
• Click on the Toggle Rulers button in the status bar below the document 

window   

  

Note: You can also right click on the document page to toggle the ruler display 

MANAGING PAGES 
Pages3D allows you to insert multiple pages of information when creating your documents. 
Each page can be unique or based on a template. 

  

INSERTING A NEW PAGE 
When a page is inserted, it will be inserted immediately following the current page shown in 
the document panel. 

  

To insert a new page after the current page 
1. Select the Home Ribbon 

2. Click on New Page 

  

To insert a new page from a template 
1. Select the Home Ribbon 

2. Use the pull down menu under New Page to select the desired page 
template. This will bring up the page template wizard. 

3. Make sure "Quick Insert" is selected. 

4. Press Finished. 
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SELECTING A PAGE 
With Pages3D, you can change pages in most of the ways you would with other page-based 
programs. For example, you can use the Page Up and Page Down buttons to flip pages in the 
order of the document. You can also use the scroll bar located to the right of the document 
view to change pages. 

The Project Panel provides a simple way to quickly turn to the exact page in a document. 

  

 To change pages using the Project Panel 
1. Select the Home Ribbon. 

2. Click on the Project Panel Button in Project Group. This will display 
the Project Panel. 

3. In the Project Panel, open the "Pages" folder. 

4. Click on the desired page. 

  

REORDERING PAGES 
Pages can be reordered after creation using the Project Panel. 

  

To reorder pages using the Pages Tab 
1. Select the Home Ribbon. 

2. Click on the Project Panel Button in Project Group. This will display 
the Project Panel. 

3. In the Project Panel, open the "Pages" folder. 

4. Click and hold down the mouse on the page you would like to 
reorder. 

5. Drag the page to the desired position in the project panel hierarchy. 

  

RENAMING A PAGE 
Pages can be named with a text identifier. These identifiers may be used during authoring to 
easily find the desired page and may be published when documents are published. 

  

To rename a page 
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1. Select the Home Ribbon 

2. Click on the Project Panel Button in Project Group. This will display 
the Project Panel. 

3. In the Project Panel, open the "Pages" folder 

4. Right-click on the desired page and choose "Properties" 

5. Change the name a select OK. 

  

USING SECTIONS AND NUMBERING 
Pages3D lets you set up sections throughout your document to designate various chapters or 
other divisions of your document. Sections can have descriptive titles and can be used to define 
the numbering system for the current page and all that follow until the next section is reached. 

Any page can be designated as the starting point for a section. 

  

To create a section 
1. Select the Home Ribbon 

2. Click on the Project Panel Button in Project Group. This will display 
the Project Panel. 

3. In the Project Panel, open the "Pages" folder 

4. Right-click on the desired page and choose Properties...� 

5. Check the box to the left of Start Section to create a section 

6. You can enter the starting number or choose to continue numbering 

7. Press OK to accept your changes 

  

User Setting Description 

Section Title A text name that describes the section. This can be used to 
automatically display section name on a document page. 

Automatically 
Choose Number 

If this option is selected the next number in the numbering defined 
prior to the start of this section will be used. 

Start Section 
Numbering from 

When the option is selected, the section will begin numbering from 
the user entered value. This is always a number regardless of the 
Style chosen below. 
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Style This field lets you choose the style of the numbering. 

  

SETTING THE PAGE BACKGROUND COLOR 
The page background color designates a color value for the current page in your document. 

  

To change the background color 
1. Select the Home Ribbon 

2. Click on the Extended Group Properties Launcher in the bottom right 
corner of the Project Group. This will display the Project Panel 

3. In the Project Panel, open the �Pages� folder 

4. Right-click on the desired page and choose Properties� 

5. Use the Background section to choose a color and enable the 
graphics on the master page or not 

  

SETTING A CUSTOM PAGE SIZE 
In general, all pages in a document will use the page size defined in the Page Settings properties 
dialog. However, as desired you can set up custom page sizes. 

  

To set up a page with a custom size 
1. Select the Home Ribbon 

2. Toggle on the Edit Page button 

3. Right click the Page and select Properties... to bring up the Page 
Properties Dialog 

4. Click the check box next to Override Page Size 

5. Select the page type or enter custom values 

6. Click OK to accept your changes 

  

WORKING WITH THE MASTER PAGE 
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Pages3D includes a master page that can provide background graphics, section titles, buttons 
for interactive documents, header/footers, page numbers and more. The Master Page is 
customizable. 

  

To edit the master page 
1. Select the Layout Ribbon 

2. Click on Master Page to begin editing the master page. Notice that 
once this is clicked, your current page�s page objects may not be 
visible anymore. 

3. Select the Insert Ribbon and create page objects as desired 

4. When you are done editing the master page, click on Check Button in 
the top-right corner of the document window. 

Note: Alternatively you can exit master page editing by: toggling off the Master Page 
button on the Layout Ribbon or by right-clicking the master page and choosing "Close 
Master Page" 

DESIGNING WITH PAGE OBJECTS 
Page objects are used to add graphics, text, images and even 3D views to you document page. 
These are easily created and positioned on a page using familiar authoring tools.  You can add 
as many page objects as necessary to create your complete document. 

  

CREATING PAGE OBJECTS 
All page objects are created by selecting a object tool and dragging a box representing the 
position and size of the new object onto the document page. 

  

To create a page object 
1. Select the Insert Ribbon 

2. Select the tool for creating your desired page object. Once the tool is 
selected and the mouse is positioned over the page, the mouse 
cursor will change indicating that it is ready to create the object. 

3. Drag a box onto the page. 
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SELECTING PAGE OBJECTS 
Page objects can be selected in order to resize, reposition or access page object properties. 

  

To select a page object with your mouse 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Click on the object with your mouse 

  

SELECTING MULTIPLE PAGE OBJECTS 
Multiple page objects can be selected allowing you to move these objects as a group, or to 
access common properties as a group. 

  

To select multiple page objects with your mouse 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Click on the first page object with your mouse 

4. Hold down [SHIFT] and continue to click additional objects 

  

To select all of the page objects on the current page 
• Press CTRL-A 

  

DELETING PAGE OBJECTS 
  

To delete a page object or multiple page objects 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select the page object(s) 

4. Click the DELETE key, or right click a page object and choose �Cut� 

  

COPYING PAGE OBJECTS 
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Page objects can be copied to clipboard for easy placement within the current document or to a 
different Pages3D document. 

To copy a page object 
1. Select the page object(s) 

2. Right click and select "Copy" (CTRL-C) 

  

CUTTING PAGE OBJECTS 
Page objects can be cut from the current page and placed on the clipboard. Once placed on the 
clipboard the objects can be pasted onto any page of the current document or into a different 
Pages3D document. 

To cut a page object 
1. Select the page object(s) 

2. Right click and select "Cut" (CTRL-X) 

  

PASTING PAGE OBJECTS 
Before pasting, a page object must be copied or cut into the clipboard. 

To paste a page object 
1. First Copy or Cut page object(s) 

2. Right click the page background and select "Paste" (CTRL-V) 

  

MOVING A PAGE OBJECT 
Page objects can be placed on the document page as desired. Once placed, the author still have 
full flexibility to move or reposition any page object as needed. 

To move one or more page objects with your mouse 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select the page object(s) 

4. Click an object (not a handle) and drag to position 

  

To move one or more page objects using the keyboard 
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1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select the page object(s) 

4. Use the arrow keys to move the objects, hold down [CTRL] to make 
more precise movements 

  
Note: The distance the objects will move with each click is determined by the grid spacing. Each 
keyboard press moves the objects by one spacing unit. If [CTRL] is held down, the objects will 
move by 1/10th of the grid spacing. 
  

RESIZING A PAGE OBJECT 
Page objects can be placed on the document page as desired. Once placed, the author still have 
full flexibility to resize any page object as needed. 

  

To resize a page object with your mouse 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select the page object(s) 

4. Click a handle and drag to resize the object 

  

To resize a page object by entering values 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Right-click on the page object and select Properties... This will display 
the "Properties" panel 

4. In the "Position" rollout, enter values for x, y, width and height 

  

ROTATING A PAGE OBJECT 
Some page objects support rotation. If the page object can be rotated, a rotation handle will be 
visible when the object is selected and the rotation field will be available from the position 
rollout. You can only rotate one object at a time. 
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To rotate a page object with the mouse 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select the page object(s) 

4. Grab the handle in the center of the page object 

Note: When using the mouse, the program attempts to snap to 45 degree increments when 
rotation values are close. If more specific rotation values are desired, you may need to 
enter the value manually. 

  

To rotate a page object by entering a rotation value 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Right-click on the page object and select Properties... This will display 
the "Properties" panel 

4. In the "Position" rollout, enter a value for the rotation in degrees 

CREATING PROFESSIONAL PAGES 
Pages3D provides many tools to help you create page layouts with precise placement and 
orientation of graphics, text and interactive objects. The different tools provide functionality 
depending on the need. 

Creating a professional document requires careful positioning of page objects relative to the 
document's margins and across multiple pages. For this type of precision, grid lines and guides 
are used to create a constant layout throughout your document. Guides are defined by the 
margin and columns settings. Grid lines are defined by the size of the document page and the 
grid spacing value. Combining the use of these tools will result in multiple page documents with 
professional page layout and design. When "snap to grid" or "snap to guides" is on, page 
objects will attempt to align with these. 
  
To carefully position page objects relative to each other Page3D provides alignment and 
distribution tools. These tools are available when multiple page objects are selected. 
  
When exact positioning is necessary, you can position page objects by typing in exact positions, 
sizes and rotations from the Properties Panel. 
  

ALIGNING PAGE OBJECTS WITH OTHER OBJECTS 
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Often, it is desired to align one page object with another. Pages3D supports page object 
alignment by allowing you to select multiple page objects and then use standard alignment 
tools to align them. 

To align page objects 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select two (2) or more page objects 

4. Select the Layout Ribbon 

5. Click on Align and choose the desired option. 

Page object alignment can be immediately modified by selecting one of the following alignment 
commands. 

Alignment Option Result 

Horizontal Left Objects will position themselves relative to the left border of the 
leftmost object 

Horizontal Center Objects will position themselves relative to the horizontal center of 
all objects 

Horizontal Right Objects will position themselves relative to the  right border of the 
rightmost object 

Vertical Top Objects will position themselves relative to the top border of the 
topmost object 

Vertical Center Objects will position themselves relative to the vertical center of all 
objects 

Vertical Bottom Objects will position themselves relative to the bottom border of the 
bottommost object 

  

DISTRIBUTING PAGE OBJECTS EVENLY 
Pages3D includes features that allow you to distribute page objects uniformly on a document 
page. This is used often when creating button controls or orienting multiple 3D views on a page. 

To evenly distribute page objects 
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1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select two (2) or more page objects 

4. Select the Layout Ribbon 

5. Click on Distribute and choose the desired command. 

Page object distribution can be immediately modified by selecting one of the following 
distribution commands. 

Distribution Option Result 

Vertical Top Object will distribute themselves evenly relative to the top of each 
object 

Vertical Center Object will distribute themselves evenly relative to the vertical 
center of each object 

Vertical Bottom Object will distribute themselves evenly relative to the bottom of 
each object 

Vertical Space 
Evenly 

Objects will distribute themselves so that the vertical spacing 
between all objects is equal 

Horizontal Left Object will distribute themselves evenly relative to the left of each 
object 

Horizontal Center Object will distribute themselves evenly relative to the horizontal 
center of each object 

Horizontal Right Object will distribute themselves evenly relative to the right of each 
object 

Horizontal Space 
Evenly 

Objects will distribute themselves so that the horizontal spacing 
between all objects is equal 

  

REORDERING THE STACKING ORDER OF PAGE OBJECTS 
The stacking order of page objects determines which objects will be placed on top of the other 
objects. This determines the visibility of objects as the lower in the stacking order, the more 
likely they are to be obscured by objects above them. 
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To evenly modify the stacking order of an object 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select a single page object 

4. Select the Layout Ribbon 

5. Click on Order and choose the desired order for the selected object. 

Page object stacking can be immediately modified by selecting one of the following stacking 
commands. 

Order Command Result 

Bring to front Move the selected object to the front of the stacking order 

Send to back Move the selected object to the back of the stacking order 

Bring forward Move the selected object forward in the stacking order 

Send backward Move the selected object backward in the stacking order 

  

SETTING PAGE OBJECT COLORS 
Page objects can be customized to display with user defined colors for fill, line and text. These 
colors can be based on the currently selected theme, or entered on the fly while authoring. 

To set page object colors 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select a single page object 

4. Use the Colors Ribbon Group to adjust the color settings for fill, line 
and text 

  

COPYING THE COLORS FROM ONE PAGE OBJECT TO ANOTHER 
Color values and settings can easily be copied from one page object to another. This is 
accomplished by capturing the style of one object and applying it to another. 

To copy the page object colors 
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1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Right-click the page object with the desired style and choose Capture 
Style 

4. Right click the page object that you would like to apply the style to 
and choose Apply Style 

  

EDITING PAGE OBJECT POSITION AND SIZE 
Page object size and position can be modified directly by setting the properties on the page 
object. 

To edit page object properties 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Right-click on the page object and select Properties... This will display 
the "Properties" panel 

4. Use the Position rollout to manually enter values 

  

ASSIGNING INTERACTIVE ACTIONS TO PAGE OBJECTS 
Some page objects can have interactive capabilities assigned to them. This allows documents to 
be created where clicking a page object results in an action such as modification of a 3D scene, 
hyperlinking to an external web page, or jumping to another page in your current document. 
There is a wide selection of actions that can be chosen. 

To assign an action to a page object 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Right-click on the page object and select Properties... This will display 
the Properties Panel 

4. Click on the Interactive Tab in the Properties Panel 

5. Use the Actions rollout to choose and action and edit the actions 
properties 

  

SETTING UP PAGE OBJECTS TO DISPLAY TEXT 
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In Pages3D, page shapes can automatically display text based on the assigned action, fields can 
be used to display specific data such as the page number, or the text can be manually entered 
by the author.  

By default, shapes do not display text unless an action is assigned to them. 

To set up a page object to display text 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Right-click on the page object and select Properties... This will display 
the Properties Panel 

4. Enable the Display Text and enter your text and/or add automatic 
fields to the output 

The fields pull down includes a wide assortment of dynamic fields that can be used as part of 
the displayed text. The following quick buttons make it easy to add the most common fields. 

Button Field 

 

Inserts a placeholder that will show the current page number 

 

Inserts a placeholder that will show the total number of pages 

 

Inserts a placeholder that will show the text defined by an button's 
action 

  

SETTING UP PAGE NUMBERS 
Inserting page numbers in a document is fairly simple. Page numbers are versatile and can be 
positioned however you desire. You may want to add the page number to the master page so 
that they will be visible on all pages. 

To set up a page object to display text 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select a page object 

4. Right-click on the page object and select Properties... This will display 
the Properties Panel 
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5. Enable the  Display Text  rollout 

6. Click the page number icon to insert a page number field 

  

SETTING UP HEADERS AND FOOTERS 
Inserting page numbers in a document is fairly simple. Headers and footers can show custom 
text or fields such as "section name". You may want to add the headers and footers to the 
master page so that they will be visible on all pages. 

To set up a page object as a header or footer 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Select a page object 

4. Right-click on the page object and select Properties�. This will display 
the Properties Panel 

5. Enable the  Display Text  rollout 

6. Type in the header or footer text and/or use fields to populate with 
special fields. 

  

ADDING NAVIGATION BUTTONS 
One of the easiest things to set up in Pages3D are navigation buttons on a page that can be 
used as custom next and previous page buttons. 

To set up a page object as a header or footer 
1. Select the Insert Ribbon 

2. Click on Edit Page (CTRL-U) 

3. Right-click on the page object and select Properties... This will display 
the Properties Panel 

4. Click on the Interactive Tab in the Properties Panel 

5. From the pull-down select an action such as Next Page 

6. Click on Edit Page to disable page editing 

7. Click the button to switch to the next page (make sure that you have 
created a document with more than one page) 

Tip: You can add navigation buttons to your master page. Once you have created buttons 
on the master page, all pages will have the same navigation capabilities. 
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ABOUT TEXT BOXES AND TABLES 
Pages3D includes various ways to work with text and tables inside a document. The following 
chart indicates the page objects that can be created on a page and how they are typically used. 

  

Text 

Page object Description Example Use 

Text Box A formatted text box that is 
positioned on a document page. 

Custom, user formatted text 

Import text from Microsoft Word, etc. 

Text Field A text box generally used for 
creating editable text fields for 
templates used with Publisher3D. 

Add a text field then save as a 
template. 

Part Text A text box that automatically 
displays text based on the 
selected object in the 3D view. 

Display part information as parts in 
the 3D view are selected 

Illustration Text A text box that automatically 
displays text based on the current 
Illustration in the 3D view. 

Displaying a caption as Illustrations are 
recalled 

Step Text A text box that automatically 
displays text based on the current 
exploded view step in the 3D 
view. 

Display detailed procedures as users 
select steps 

  

  

Tables 

Page object Description Example Use 

Table A formatted table that is 
positioned on a document page. 

Custom, user created table. 
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Parts Table A table displays a parts list. Displaying a parts list on a document 
page. Tables can be set up to allow 
association with the 3D view. 

Illustration 
Table 

A table that displays a list of the 
Illustrations in a storyboard. 

Displaying a list of Illustrations on a 
document page. Tables can be set up 
to allow association with the 3D view. 

Step Table A table that displays a list of 
steps in an exploded view. 

Displaying a list of steps on a 
document page. Tables can be set up 
to allow association with the 3D view. 

  
  

WORKING WITH TEXT BOXES AND TABLES 
When a text box, table, active text or active table is selected in page layout mode, the border 
color will indicate the status of the text object. 

Border Color What does it mean? 

Blue All of the text or table rows are currently visible in the text box or the 
text box is linked to another text box and overflowed text is displayed 
there. 

Red The text box contains text or table rows that are currently not visible 
and the text box or table is not linked to another text box (see linkable 
text). You can resize the text box to view the additional information. 

  

  

UNDERSTANDING ACTIVE TEXT AND TABLES 
Pages3D includes unique page objects that are used to make use of metadata that is assigned 
parts, steps and snapshots. These page objects make it very easy to use 3D metadata and make 
it accessible on a document page. 
  
When you create an active text box or table, you will assign various fields that will be used to 
populate the columns or display as text.  
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You do not add information by typing into the active text box; you add information by 
assigning metadata to illustrations, parts or exploded steps. 
  
You can use active text to display a field or fields as the user interacts with the 3D view. You can 
use active tables to provide a list of options that a user can click on to modify the 3D view. 
Active text and tables can be used together to create a table that will display metadata as items 
are clicked. 
  

STANDARD TEXT BOXES AND TABLES 

INSERTING A TEXT BOX 
Text boxes can be inserted into documents at any position or on any page. 

To insert a text box 
1. Select the Insert Ribbon 

2. Click on the Text Box button 

3. Drag a box to the document page 

  

SELECTING A TEXT BOX 
Text boxes can be selected like any other page object. When a text box is selected, the cursor 
for text entry will automatically be positioned at the end of the existing text. 

To select a text box 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the text box to select it. 

  

When a text box is selected, the border color indicates if all the text is visible (blue) or some 
text is not visible (red). If some text is not visible, you can resize the text box to display the text 
or link the text box to another so that overflow text will be displayed in the other text box. 

  

POSITIONING A TEXT BOX 
Text boxes can be positioned as desired on any document page. Transparent text boxes cannot 
be place over interactive components. This will result in a hashed out text box. 

To position a text box 
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1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the text box to select it. 

4. Click and drag the handles to resize, or click and drag the solid border 
to reposition. 

Note: Text boxes cannot be rotated. 

  

IMPORTING TEXT FROM OTHER DOCUMENTS 
Pages3D includes tools for importing text from various other text formats, such as .DOC, .DOCX, 
.RTF, and .HTM. These documents can be used to fill a single text box or multiple text boxes by 
linking the original text from one box to another. 

To replace the text in your text box with imported text from 
Microsoft® Word® 

1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the text box to select it 

4. Right-click the text box and select Import Document from File... 

5. Browse and pick the desired file to import 

  

To replace the text in your text box with imported text from RTF or a 
text file 

1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the text box to select it. 

4. Right-click the text box and select Import Document from File... 

5. Browse and pick the desired file to import. 

  

USING THE SPELL CHECKER WITH A TEXT BOX 
Pages3D includes an integrated spell checker. If the spell checker is activated, misspelled words 
will automatically be highlighted with a red underline indicator. 

To use the spell checker 
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1. Turn on Edit Page. 

2. Click on a text box. 

3. Type your text, and notice as misspelled words become highlighted 
with the red underline. 

4. Right click words with the red underline and select a replacement 
word, add the current word to the dictionary, or ignore. 

  

INSERTING A TABLE 
Tables can be inserted onto document pages. Once inserted, tables can be positioned; resized 
and other properties such as rows and columns can be modified. Rows and columns can be 
added and deleted as necessary after the table has been created. 

To insert a table 
1. Select the Insert Ribbon. 

2. Click on the Table tool. 

3. Drag a box to the document page. 

4. Enter the initial number of rows and columns for the table. 

  

SELECTING A TABLE 
Tables can be selected for repositioning or editing of content. When a table is selected, the 
border color indicates if all the text is visible (blue) or some text is not visible (red). If some text 
is not visible, you can resize the text box to display the text. 

To select a table 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the table to select it. 

  

POSITIONING A TABLE 
Tables can be positioned on your document page as desired. Tables cannot be rotated. 

To position a table 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 
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3. Click on the table to select it. 

4. Click and drag the handles to resize, or click and drag the solid border 
to reposition. 

Note: Tables cannot be rotated. 

  

RESIZING THE COLUMN WIDTH 
Individual columns in a table can be sized as desired. 

To resize the column width with the mouse 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the table to select it. 

4. Grab a divider between columns and resize as desired. 

  

SETTING THE ROW HEIGHT 
By default, row height is determined by the contents of the cells. For more control, you can 
manually set a minimum height for a row. 

To set the minimum row height 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the table to select it. 

4. Right-click a row and choose Table > Cell Properties from the popup 
menu. 

5. From the Size and Formatting tab, choose "At Least:" and enter a 
value in inches. 

  

SETTING CELL PROPERTIES 
Individual cells have many properties such as color, height, alignment, and others. 

To set properties for an individual cell 
1. Select the Insert Ribbon. 
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2. Click on Edit Page. 

3. Click on the table to select it. 

4. Right-click a row and choose Table > Cell Properties from the popup 
menu. 

  

INSERTING A NEW ROW 
Rows can be inserted above or below any selected row. 

To insert a new row 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the table to select it. 

4. Click and select a row. 

5. Right-click and choose Table > Insert Row Above or Table > Insert 
Row Below to create a new row. 

  

INSERTING A NEW COLUMN 
New columns can be inserted to the left or right of any specified column. 

To insert a new column 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the table to select it. 

4. Click and select a column. 

5. Right-click and choose Table > Insert Column to the Left or Table > 
Insert Column to the right to create a new column. 

  

DELETING A ROW 
When a row is deleted, all displayed text and formatting for the deleted row is removed from 
the document. Rows below the deleted row will be shifted up. 

To delete a row 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 
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3. Click on the table to select it. 

4. Click and select a row. 

5. Right-click and choose Table > Delete Row. 

  

DELETING A COLUMN 
When a column is deleted, all displayed text and formatting for the deleted column is removed 
from the document. Columns to the right of the deleted column will be shifted left. 

To delete a column 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the table to select it. 

4. Click and select a row. 

5. Right-click and choose Table > Delete Column. 

LINKABLE TEXT AND TABLES 
Linkable Text boxes and tables allow you to include long streams of text in your document and 
display this across different pages or different text boxes on the same page. This capability 
allows users to create and manage robust manuals with large amounts of text. Linked text 
boxes are designed to provide a user interface and technology to manage text overflow from 
one text box to another. 

The following graphic indicates how a long text stream is divided between standard text boxes 
in your QuadriSpace Document. In this example, three text boxes are used to display all of the 
text; the first text box displays as much of the text as possible, then the second text boxes and 
finally the third text box is able to display the remaining text. 
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Linked text boxes are the same page object as the standard text box. These text boxes will 
automatically adjust and add icons to reflect the overflow or lack of overflow in the text box. 
When the text box is selected in "Edit Page" mode, the color of the selection indicator will 
provide some information about the state of the text box. 

A blue border indicates that all of the text is visible OR the text box is properly linked to another 
allowing overflow text to display in another box. 
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A red border indicates that there is more text in the text box than what is currently visible AND 
that the text box is not linked. This means that when a text box is red, your document includes 
text that is not visible. 

 

In general, you do not want documents that include red bordered text boxes. To turn red 
borders blue, you can: 

• Resize the text box so that all text fits within the text box borders 

• Adjust the font or paragraph properties of the text so that all text fits 

• Link the text box to another, so that overflow text will continue to display on another 
page or on another area of the current page 

There are a number of ways to add text to a document: 

• A text box can be created and text can be simply typed into the text box as desired 
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• A text box can be created and text can be imported using the right click, "Import 
Document" command 

• Text can be copied from one application into a Pages3D text box 

• Text can be copied from another application onto a Pages3D page (if this option is 
used, Pages3D will automatically create a single text box. 

When text is imported or copied in, often the new text is longer than the available display area 
represented by the single text box. If this is the case, the text box will display a red border once 
the text is imported. 

When text is typed into the text box, text is added and may at some point result in text 
overflow. At this point, the text box will change from a blue border to a red border. If the text 
box is not linked, then all new text that is typed will automatically scroll as more text is entered, 
but once the text box is deselected, the text will roll back up until the top line is again 
displayed. 

If the text box is linked, as more text is typed into text box, all relevant boxes will be updated. 
These updates may occur after a short delay once typing has completed. If you encounter the 
end of a linked text box, the cursor will jump to the linked text box and typing will be captured 
as expected. 

  

LINKING TEXT BOXES 
Linking one text box to another text box results in any text from the first text box that overflows 
the boundaries of the text box with the text can be set up to flow from one area to another. 

A text box that needs to be linked will display a "add link" button (a plus sign) in the bottom-
right corner of the text box when "Edit Page" is active. Clicking on this button will display a 
menu that is used to choose from a variety of commands. Clicking this button will allow you to 
add a new text box that is automatically linked to the current text box, or select an existing text 
box to link to. The latter option is very useful when working with templates and attempting to 
link text boxes together. 

 

A text box that is already linked to other text boxes will display a "edit link" button (a chain link) 
in the top-right or top-left corner when "Edit Page" is active. The top-right button is used to 
modify the link to the text box that is contributing the overflowed text. Clicking this button will 
allow users to stop linking or reset the text box to link to a different contributor of text. 
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CREATING A LINKABLE TEXT BOX 
A linked text box is the same as a standard text box. If you are creating a text box as the starting 
point, and you expect text to overflow into other text boxes, simply create the text box, or start 
typing into an existing text box. If you are creating a text box to link overflow text into, simply 
create a text box as desired on your document page or insert a template that includes a 
standard text box. For specific steps regarding the creation of text boxes, see help topics on 
creating a standard text box for more information. 

  

LINKING A TEXT BOX TO AN EXISTING TEXT BOX 
When a text box is linked to another, the overflow text from the first text box will automatically 
fill the second text box. Linking text boxes provides complete control of the page design as text 
can be set up to avoid images on a document page and can flow smoothly from one page of the 
document to the next. 

To link a text box 
1. Select the Home Ribbon. 

2. Turn on Edit Page. 

3. Click on the Plus Icon in the bottom right corner of the text box to link 
from, then select Link to a text box�. This will activate the link tool, 
and a cursor with a chain link will be activated. 

4. Next, click on the text box that you want to link overflow text into. 
You can change pages after activating the link tool. 

Note: If there is text in the second text box, that text will be overwritten. 

  

LINKING A TEXT BOX BY CREATING A NEW TEXT BOX 
Another method for creating a series of linked text boxes is to create the first text box and fill it 
with the large text stream. Then create each subsequent text box by linking the first to the 
second; the second to the third and so on. 
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To link a text box 
1. Select the Home Ribbon. 

2. Turn on Edit Page. 

3. Click on the Plus Icon in the bottom right corner of the text box to link 
from, then select Insert Linked Text Box... This will activate the link 
tool, and the cursor will switch to the standard insert page object 
cursor. 

4. Next, drag out your text box onto the page in the desired location. 

  

REMOVING LINKS TO OTHER TEXT BOXES 
When a linked from one text box to another is removed, the overflow text will no longer display 
in the second text box. Depending on the amount of text, the first box may display a red outline 
when selected indicating that the box contains text that is not being display. 

To remove a link from one text box to another 
1. Select the Home Ribbon 

2. Turn on Edit Page 

3. Click on the Link Icon in the bottom-right or top-right corner of the 
text box, then select Stop Linking. This will remove the link. If the 
bottom button was clicked, the text feeding into the text box will be 
unlinked, resulting in an empty text box. If the top button was clicked, 
the text feeding out will be unlinked and the text box will display a 
red selection border indicating overflowing text. 

ADDING IMAGES AND SHAPES 
Documents can include raster images and other graphical elements, such as shapes. These 
elements are inserted onto the document page and will be display whenever the current page 
of the document is viewed. By default, new objects are added to the top of the page object 
stack. 

The software include a library of stock images relevant to technical documentation. The library 
includes an assortment of arrows, tools, buttons, warnings, indicators, and more.  

  

INSERTING AN CUSTOM IMAGE 
Pages3D supports a wide-range of standard images; such as JPG, TIF, GIF, BMP and others. 
Transparent images are not supported. 
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To insert an image 
1. Select the Insert Ribbon. 

2. Click on the pulldwn arrow under the Image Tool. 

3. Select an image from the library of stock images. 

4. Drag a box to the document page. 

  

INSERTING AN CUSTOM IMAGE 
Pages3D supports a wide-range of standard images; such as JPG, TIF, GIF, BMP and others.  

To insert an image 
1. Select the Insert Ribbon. 

2. Click on the Image Tool. 

3. Drag a box to the document page. 

4. A file dialog will display; browse and pick the image file to import. 

  

SELECTING AN IMAGE 
Selecting an image will allow you to reposition the image, resize the image and adjust the 
image's properties. 

To select an image 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the image to select it. 

  

POSITIONING AN IMAGE 
Images can be positioned anywhere on a document page. 

To position an image 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the image to select it 

4. Click and drag the handles to resize, or click and drag the solid border 
to reposition. 
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WORKING WITH SHAPES 
Pages3D includes various graphics, such as shapes, symbols and connectors. These can be used 
to set up your document page. Graphics can be positioned, resized and rotated to fit your 
documentation's needs. 

Shapes can be used to accomplish the following: 

• Graphical elements on a page or master page 

• Interactive Buttons 

• Display text fields such as page numbers, headers, footers 

  

INSERTING A GRAPHIC 
When a shape is added to a document page, the shape will be added to the top of the stacking 
order. 

To insert a shape 
1. Select the Insert Ribbon. 

2. Click on the desired shape. 

3. Drag a box to the document page. 

  

SELECTING A GRAPHIC 
Shapes can be selected so that they can be repositioned, resized, deleted or have their 
properties adjusted. 

To select a shape 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the graphic to select it. 

  

POSITIONING A SHAPE 
Shapes can be size, moved or rotated. 

To position an shape 
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1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Click on the graphic to select it. 

4. Click and drag the handles to resize, or click and drag the solid border 
to reposition. Click and drag the center handle to rotate. 

INSERTING 3D CONTENT 
Pages3D supports the import of 3D content and the placement of views of this 3D content on a 
document page. 

  

IMPORTING A 3D MODEL 
There is a wide-range of supported 3D formats for import. When a model is imported, Pages3D 
will automatically create a 3D view on your document page. The interface will automatically be 
placed into "Edit Page" mode for positioning the new view on your document page. You can 
disable this mode to interactively rotate, pan and zoom the 3D model. 

To import a 3D model 
1. Select the Home Ribbon 

2. Click on 3D View 

3. Drag the position of the 3D view onto the page 

4. Browse and select the file to import. 

Note: You can import models by dragging a model file from your file explorer onto a 
document page. 

  

REUSING PREVIOUSLY IMPORTED 3D MODELS 
In most cases, it makes sense to import a model once and reuse the same model with multiple 
views of the 3D model. This saves file and memory size since a single representation of the 3D 
model is used for multiple views. There are a number of ways to create a view without 
importing the model a second time. 

To create a view using the Insert Ribbon 
1. Select the Insert Ribbon. 

2. Click on 3D View. 

3. Drag a view to the page. 
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4. A dialog will display listing the 3D models that have already been 
imported into your document, choose one. 

  

To create a view by dragging from the Project Panel 
1. Select the Home Ribbon. 

2. Click the Project  button in the Project Group to display the Project 
Panel. 

3. Drag the desired scene from the Project Panel to your document 
page. 

  

To create a view by copy/paste 
1. Select the Insert Ribbon. 

2. Click on Edit Page. 

3. Right-click the 3D view and choose Copy 

4. Switch to the page you would like to copy to 

5. Right click the page background and choose Paste 

  

USING 3D VIEWS 
Working with 3D views requires using "Edit Page" mode to position and resize the view. When 
this mode is inactive, the 3D scene is interactive. 

  

What to do when "Edit Page" is active 

• Position the view on the document page 

• Resize the view 

• Select the view to set properties 

• Set up interactive objects that work with the view 

What to do when "Edit Page" is NOT active 

• Use the mouse to rotate, pan and zoom 

• Create Illustrations 

• Edit and document the 3D model 
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• Modify render styles 

• Select viewpoints 

• Edit sections 

  

POSITIONING A 3D VIEW ON A PAGE 
Positioning the 3D view works a lot like positioning other page objects. These views can be 
resized and repositioned, but you cannot rotate a 3D view on the document page. 

  

To position the 3D view on a page 
1. Select the Insert Ribbon 

2. Click on Edit Page. Each interactive view on the document page will 
display differently to indicate that the view is ready to be positioned. 

3. Select the 3D view to activate the handle. 

4. Click and drag handles to resize the view; click and drag the view to 
reposition 

  

INTERACTING WITH 3D MODELS 
The 3D content inside the 3D view can be rotated, panned, zoomed and much more using the 
3D tools included with Pages3D. 

  

To interact with the 3D model in the view 
1. Select the Home Ribbon 

2. Click on any of the interactive tools in the Viewpoint Group 

3. Use your mouse to rotate, pan and zoom the 3D 

  

EDIT 3D VIEW PROPERTIES 
3D Views have a number of important properties that determine how 3D views are used in the 
document that you are creating. 
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To modify the 3D view properties 
1. Select the Home Ribbon. 

2. Toggle on Edit Page. 

3. Select the 3D View by clicking on it. 

4. If the properties panel is not visible, right click the 3D View and 
choose "Properties" to display the Properties Panel. 

  

ADVANCED SETTINGS 
The following settings can be set from the Import tab on the 3D View Properties Panel. 

Enable Mouse Navigation: Uncheck this to turn off the mouse's ability to rotate, pan or 
otherwise interact with the 3D view. 

Honor BOM for Selection: � When this is selected, mouse selecting in the 3D view will select 
the items in the relevant BOM row instead of just the part. 

Show Select Objects Only: � When this is selected, this view will pick up selections of other 
views on the page and display the an isolated view of the selected parts and hide all other parts 
automatically. 

Limit to Single Selection: This will setup the view to disallow multiple part selection. Generally, 
this is used for greater compatibility with PDF. 

  

  

ADDING A MODEL OR TEXTURE SEARCH PATH 
In some cases the imported model may include external references to parts or textures. You 
can add paths to search various directories for these. These settings are saved to the registry so 
that you will not need to add them each time the program is used or for various imported 
model. 

To add a model or texture path 
1. Click on the Application Menu. 

2. Choose Options. 

3. Click on the Paths selection. 

4. Next to the model or texture path, click the Edit... button. 

5. Click on Add Path. 
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CONTROLLING THE 3D VIEW 
SETTING UP PRECISE VIEWPOINTS 
When creating documents or Illustrations, it is often important to set up precise viewpoints. 
The Viewpoint Panel allows you to create specific viewpoints of your 3D model and reuse the 
same viewpoint throughout your document. This makes it easy to create industry standard 
views and to keep viewpoint within a document uniform. 

Using the Viewpoint Ribbon Group and the Viewpoint Panel, you can quickly: 

• Choose from common viewpoints 

• Choose from a library of industry-standard axonometric views 

• Set up precise views of your own by typing in offset and tilt angles 

  

CHOOSING THE MODEL ORIENTATION 
The viewpoint tab requires that the model's up-axis is properly defined. The up-axis determines 
how all of the viewpoint choices behave. If you find that you are pressing the top button and 
the viewpoint is changed to the right then you will be able to resolve this by choose the correct 
up axis. 

  

To choose the up-axis for the model 
1. Select the Model Ribbon 

2. Click on the Up Direction button to choose a setting 

3. Once you have chosen a setting, you can test this by choosing the 
Front view or Top view to verify that the correct axis is up. 

  

SELECTING STANDARD VIEWS 
Standard views are the views typically found in 3D viewers and CAD tools. These include the six 
standard orientations such as front, top, right, etc and the common axonometric views such as 
isometric, dimetric and trimetric. 

  

To select a standard view 
1. Select the Home Ribbon. 
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2. Click on the Custom... from the orientation pulldown to display the 
Viewpoint Panel. 

3. On the Viewpoint Panel, open the Standard Views rollout. 

4. Click the desired orientation. 

  

SETTING UP AN AXONOMETRIC VIEWPOINT 
Setting up an axonometric view requires two (2) simple choices. First, you will need to choose 
the type of axonometric view. This is chosen from a library of industry-standard viewpoints. The 
second choice is the orientation that you would like to view from. This is a choice from that 
determines whether the viewpoint is top or bottom, left or right, and front or back. 

  

To select an axonometric view 
1. Select the Home Ribbon. 

2. Click on the Custom... from the orientation pulldown to display the 
Viewpoint Panel. 

3. On the Viewpoint Panel, open the Axonometric Views rollout. 

4. Use the pull down to select the type of axonometric view; this will 
rotate the model into place. 

5. Select an orientation from buttons on the second row. The red dots 
indicate the viewpoint relative to the model. 

  

Isometric Views 

Selection Comments 

Isometric 30 Isometric view commonly used by CAD tools 

Isometric 27 (1:2)   

Isometric 45 Commonly used for military documents 

  

Dimetric Views 

Selection Comments 
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Dimetric 42/7 Common technical Illustration view 

Dimetric 15-45-45   

Dimetric 20-40-40   

Dimetric 55-25-25   

Dimetric 70-10-10   

  

Trimetric Views 

Selection Comments 

Trimetric Standard Trimetric View 

Trimetric 15-55-30   

Trimetric 20-35-50   

Trimetric 30-50-25   

Trimetric 50-15-35   

Trimetric 70-15-10   

  

CREATING CUSTOM PRECISION VIEWPOINTS 
You can set up custom views by choosing an offset rotation and a tilt angle. 

  

To set up a custom view 
1. Select the Home Ribbon. 

2. Click on the Custom... from the orientation pulldown to display the 
Viewpoint Panel. 

3. On the Viewpoint Panel, Open the Custom Views rollout 

4. Choose the initial orientation. This will be the starting point. 
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5. Click the offset angle box and enter a value between -90 and 90 
degrees. 

6. Click the tile angle box and enter a value between -90 and 90 degrees. 

Once you have set up a view that you like, you can simple click the orientation buttons to view 
the same setup from different starting orientations. 

  

1. ype in your desired value 

SETTING UP THE RENDER STYLE 
The render style assigned to a view determines the overall visual characteristics of the view. 
The render style determines the way face materials, lines, selected objects, backgrounds and 
other visual attributes are visualized within the entire view. You can choose from standard 
styles, apply named styles from an included library or create custom styles. 

Illustrations capture the render style and when they are recalled, the render style of the view 
will be changed to the captured style. 

Render styles are applied globally to a view, if you need to modify materials for specific parts 
you should edit specific part materials using the Materials Tab. 

You can use the Render Style Ribbon group to make simple adjustments or recall previously 
saved render styles or you can use the Render Style Panel to customize the render style to your 
specific needs. 

One trick that is used to create a scene with various render styles between parts is to modify 
the Selected Object settings. Using this practice, you can set up scenes that show some parts in 
gray outline and the focus parts in full color or outline the focus parts and leave the background 
parts without outlines. There are limitations to this approach because the only parts that can be 
highlighted in this way are the selected parts; if you are using tools such as sectioning of 
selected parts only or simply want to show selection too, this technique may not work for you. 

Other than modifying selection parameters, changing the render style settings will not allow 
users to modify individual parts visual settings. To change the drawing properties of individual 
parts, you will need to modify the materials on the parts. 

  

RENDER STYLE RIBBON GROUP 
The Render style ribbon allows you to use a variety of tools to adjust the render style to your 
desires. 
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To use the render style ribbon group 
1. Select the 3D View Ribbon 

2. Click on a 3D view to select it 

3. Adjust settings as desired 

RENDER STYLE PROPERTIES 
Draw Style Settings 

Render Style Description 

Wireframe Renders the outlines of the 3D only. No faces are drawn. 

Hidden Lines Removed Renders the outlines of the 3D only. No faces are drawn and 
hidden lines are removed. 

Hidden Lines Dashed Renders the outlines of the 3D in a solid color and renders the 
hidden lines in a minor color and dashed. 

Shaded with Edges Render shaded faces with outlines. 

Shaded Renders shaded faces only. 

Semi Transparent Renders all parts as semi-transparent 

  

Background 

Use these settings to set the background style and color. 

Highlight 

Use these settings to determine how selected parts will render. The selection box is used to 
determine how the render style applies color to the faces. To turn edges off, set the edge width 
to zero. 

Show selection highlight allows you to add a fading selection indicator that forms a halo-effect 
around the selected objects. The color for this effect can be set independent of the selection 
color. Typical use would be to set this color to a color similar to the selected Face color 
according to desired style. 

Edges 
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Use these settings to determine how edges will be drawn. You can use the selection box to 
determine how the render style applies color to the edges. The crease width is used for all 
edges that are not on the outside of a 3D part. The boundary width is used for all edges that are 
on the exterior of a 3D part. 

Trails 

When trails are activated, the 3D view will render solid, dashed or dash-dot lines for explode 
steps. You can set which trails are actually rendered by selecting a type. Trails can be rendered 
for all steps, the current step only and for selected parts only. 

Lighting 

These options determine how lighting is applied to the 3D view. If this is left unchecked, 3D 
model will be drawn without lighting which typically results in a non-shaded 3D view. 

Appearance 

These settings allow you to apply shiny materials to the entire scene. 

  

RENDER STYLE PANEL 
The render style panel provides complete customizable control of your scenes render styles. 
There are a number of additional properties available when the panel is used. 

  

To activate the Render Style Panel 
1. Select the 3D View Ribbon. 

2. Click on the Properties button in the Render Style ribbon group 

  

RENDER STYLE TAB 
The render style tab allows you to adjust settings that define how the 3D model is rendered. 
These setting will determine how the entire scene is rendered. 

  

To access render style properties 
• On the Render Style Panel, click on the render style tab. 

  

Custom Material 
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Check this box to tell the render style to modify the appearance and color as defined. The 
selection box lets you determine how the faces will be rendered. This choice determines what 
options are available for modification. 

Ambient, diffuse and specular when available will apply to all parts of the model. You can 
choose a material type to apply effects such as mirrored or metal to the entire scene. The 
shininess and opacity are also applied to the entire rendered view. 

These settings allow you to apply a custom material to the entire scene. You can apply a single 
shaded material, set this to show only the background color, or only modify the appearance of 
the scene but keep material colors intact. A common use of the latter option is to apply an 
environment map to the entire scene without changing each material individually. 

Filled Section 

Check this box to activate filled sections. Choose to use part colors for the filled areas or a 
custom color. 

  

  





105 

MANAGING MATERIALS 
CREATING MATERIALS 
Materials can be created from scratch or by cloning an existing material. 

  

To create a new material 
1. Select the Material Ribbon. 

2. In the Materials Group, select Materials > New Material. 

3. The Properties Panel will display allowing you to modify the materials 
properties. 

  

To clone an existing material 
1. Select the Material Ribbon. 

2. In the Materials Group, select Materials > Clone Material. 

3. The Properties Panel will display allowing you to modify the materials 
properties. 
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MANAGING PROJECTS 
UPDATING WHEN 3D CAD CHANGES 
During the life of a 3D CAD design there are many changes that occur. Updating documents, 
illustrations and animations can be extremely time consuming and tedious. Document3D Suite 
provide an easy way to import updated designs as the 3D CAD design changes. This allows you 
to keep your document up-to-date and spend more time improving the information. 

Updating applies directly to modified parts that retain the same name as the original imported 
file. Replacement parts or new parts to do not have a matching name will generally require 
some manual steps as part of the update. For helping with the manual steps of an update, the 
software includes: 

• An optional display type for the Model Panel to list any new or replacement parts 
• Color-coded identification of explode steps that include steps where parts have been 

removed 
• Advanced tools that allow you to manipulate parts in batch processes relative to a 

storyboard 
  

UPDATING MODELS 
  

To update the current model 
1. Select the Configurations Ribbon 

2. In the Update Group, select Update to bring up the Update Dialog 

3. Click on the checkbox next to the files that require updates and click 
the '...' button to browse to select new filenames, if necessary. 

  

UPDATE MODEL OPTIONS 
Generally, it is best to use the default option when updating documents or illustrations sets 
with a revised 3D model. However, in some cases it is useful to modify these settings.  

To update the current model 
1. Select the Configurations Ribbon 

2. In the Update Group, select Update to bring up the Update Dialog 

3. Click on the "Options" button to display the Update Model Options 

You can change the following settings: 
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Option Description 

Maintain Material 
When checked, does not replace 
material changes from the 
incoming model. 

Update Thumbnails 
after Update 

Not generally necessary, but 
when checked forces all 
illustration thumbnails to 
update. 

Delete Original 
Model before 
Update 

Not generally necessary, may be 
useful for very large models. 

Use Displayed Part 
Name (DWF Only) 

May be useful when updating old 
files where the original model 
was DWF and matching part 
names. 

Match parts by name 
only 

Default setting will only match 
parts based on the name of the 
part in the CAD. This consistently 
matches parts since the 
matching is based on an absolute 
and easily compared name. Will 
update modified parts. 

Match parts by 
location 

Optional setting. The software 
will attempt to match parts 
based on their location within 
the model. The software will 
attempt to identify matches. This 
is useful for replacement parts. 
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UPDATE TAB IN THE MODEL PANEL 
After an update you will find a new option in the Model Panel that will display the new parts 
that were added to the model on update. This can be used to easily find, toggle selection, and 
toggle visability to make manual changes to your illustrations when an update includes new 
parts or replacement parts.  

  

To view the list of new or replacement parts 
1. Display the Model Panel 

2. From the pulldown at the top, choose "Update (New Parts)  

  

MISSING PART IDENTIFICATION IN THE EXPLODE STEP PANEL 
After an update you will find that exploded views may indicate missing parts by color-coding 
the step in the exploded step tree. You can use this information to quickly match and add to the 
step replacement parts that will likely be found from the "Update" selection in the Model 
Panel. 

  

To view the list of missing parts 
1. Display the Exploded View Panel 

2. Steps with missing parts will be highlighted in red 
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3. Generally, you can resolve this conflict by right clicking the 
highlighted step and choosing "Edit Step Details" 

4. Add a replacement part to the step by CTRL-clicking it in the 3D view 
or CTRL-clicking it in the Model Panel. 
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VIEWING WITH READER3D 
USING READER3D 
Reader3D stand-alone can be installed on any Windows-base computer. 

  

OPENING A QUADRISPACE MODEL (QSM) 
  

To open a QSM file 
1. From the Application Menu in Reader3D, choose Open. This will bring 

up the file browser. 

2. Choose QuadriSpace Models (QSM) to show only QSM files in the 
browser 

3. Select the desired QSM 

4. Click OK 

  

OPENING A QUADRISPACE DOCUMENT (QSD) 
  

To open a QSD file 
1. From the Application Menu in Reader3D, choose Open. This will bring 

up the file browser. 

2. Choose QuadriSpace Models (QSD) to show only QSD files in the 
browser 

3. Select the desired QSD 

4. Click OK 
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OTHER 
EXPORTERS FOR 3D CAD SOFTWARE 
  

EXPORTER FOR 3DS MAX 
The Exporter for 3ds max can be installed on a computer that has 3ds max or Autodesk VIZ 
installed. 

  

EXPORTING FROM 3DS MAX OR AUTODESK VIZ 
  

To export your 3D Studio models to QuadriSpace Model Files (QSM) 
using the Exporter for 3ds max 

1. Open 3ds max or Autodesk VIZ 

2. Load your model 

3. Select the File > Export menu option 

4. Select QuadriSpace Exporter from the Save as Type pull down 

5. Select the directory and filename to export the model to 

6. Press Save 

  

This will begin exporting your model.  Please note that large models may take several minutes 
to export.  The progress of the export is shown on the progress bar at the bottom of the 3ds 
max or Autodesk VIZ user interface. If the QuadriSpace Exporter does not support features used 
when the model was created, then a dialog box listing the errors will be displayed. 

  

SUPPORTED FEATURES 
The following lists the 3ds max and Autodesk VIZ features supported by the Exporter for 3ds 
max. 

• All geometry that can be represented as a triangle mesh 

• Standard Materials 

• Multi-Sub Objects 

• Bitmap Textures if in one of the following Texture Map types 
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• Baked Textures 

• Diffuse Color Map 

• Bump Map 

• Self Illumination Map 

• Direct, Spot and Omni Lights 

• Cameras 

  

USING BAKED TEXTURES 
If you are using 3D Studio MAX 5 or later, you have the ability to use "Baked Textures".  This is 
available through the Render to Texture option under the Rendering menu in 3D Studio.  The 
following is from the 3D Studio User Reference 

"Rendering to texture", or"texture baking," allows you to create texture maps based on an 
object's appearance in the rendered scene.  The textures are then "baked" into the object: that 
is, they become part of the object via mapping and can be used to display the textured object 
rapidly..." 

Some possible uses of Baked textures are: 

• Generating simple bitmap textures from procedural textures 

• Exporting a Radiosity lighting solution as a light map 

• Creating light and shadow maps 

The Exporter for 3ds max supports the  Render to Texture feature.  When you export a model 
that has "baked" textures, the exporter will ask you how you wish to use the baked 
textures.  The selection that you make will apply to ALL objects that use baked textures.  You 
are not able to make a per-object selection.  The options for using baked textures are: 

Option Description 

Use Original Material The baked texture is ignored.  You original texture maps will be 
used 

Use Baked Material 
Only 

The baked texture will replace both the diffuse map and light map 
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Use Baked Material 
as Diffuse Map 

The baked texture will replace the diffuse texture map.  The light 
map, if specified, will still be used 

Use Baked Material 
as Light Map 

The baked texture will replace the light map.  The diffuse map, if 
specified, will still be used. 
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